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About This Manual

This manual provides instructions for how to setup, operate, and
troubleshoot your OverLAN Router. To follow the instructions,
you need only a limited knowledge of technical terms. Where
such terms appear, they are in Italisized boldface and their
definitions are in the glossary at the back of the manual.

This manual is organized into the following sections:

• Getting Started
A brief overview of the product with an explanation of tools
or other components you may need.

• Installing
Illustrated instructions and helpful hints to quickly guide
you through every step of installing the router.

• Configuring
Explanations of setup options for the router.

• Operating
Illustrated instructions to quickly guide you through the
basic operation of the router.

• Troubleshooting
Suggestions on how to resolve any problems that may occur
during the setup of your router.

• Glossary
Definitions of all the terms that are in boldface.
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Getting Started

The following items are included in the OverLAN router package:

• The Ethernet/ISDN router,
• An RJ11 - DB25 communications cable,
• An unshielded RJ45 ISDN cable,
• The power cord,
• A 10BASE-2 T-connector,
• 3.5 inch disk(s) for OverLAN Commander,
• This manual and a warranty return card.

Before starting to setup the router,  you need the following:

• A fully operating Ethernet using TCP/IP and/or Novell
Netware,

• An NT-1,
• A shielded RJ45 Ethernet cable,
• An ISDN BRI line -- you will need to know the ISDN

phone number(s) and SPID (only required in the USA)
number(s),

• A 9DB - DB25 pin adaptor if you have a computer with a
9-pin serial port,

• A computer running Microsoft Windows (version 3.11 or
greater), or optionally an ASCII terminal or a computer
running terminal software.

No additional tools are needed to install your router.
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Installing the
OverLAN

Router

Four Easy Tasks

INSTALLING the OverLAN ROUTER
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Installing the OverLAN Router

Task 1:  Connecting the router to an Ethernet
network using one of the following methods:

METHOD 1: 10BASE-T

Step 1:
Connect one end of a shielded RJ45 cable into the
10BASE-T interface on the back of the router -- see
figure 1.

Figure 1

Step 2:
Connect the other end of the cable into the 10BASE-T
interface on the hub of the Ethernet -- see figure 1.

Always use a HUB in a 10baseT environment to connect
your ISDN Router to the network. NOTE: Do not use
crossover cable.

This completes Task 1.

INSTALLING the OverLAN ROUTER

Hub must be
installed before the
router can be
installed.

Ethernet Hub

10BASE-T Interface
Back of Router

Shielded
RJ45 cable

Serial
ISDN Line10base2Power Reset
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METHOD 2: 10BASE-2

Step 1:
Connect a thin-coax T-plug into the 10BASE-2 port on the
back of the router -- see figure 3.

Figure 3

Step 2:
Connect a thin-coaxial cable used for the Ethernet to the
T-plug located on the back of the router -- see figure 3.

If the router is not at the termination of the Ethernet, then
connect the coaxial cable that continues the Ethernet to the
T-plug -- see figure 3.

If the router is at the termination of the coaxial cable, then
be sure that the unused end of the T-plug has a terminating
resistor;  if not, attach a terminating resistor to the unused
end of the T-plug -- see figure 3.

There should be a minimum thin-coaxial cable length of
10m.  Otherwise both ends of the Terminators will be too
close together, (802.2 spec).

This completes Task 1.

continuing Ethernet

Coaxial cable for

10BASE-2 Port

Terminating resistor

Back of Router

T-plug

or
Coaxiable cable

for Ethernet

Power
Serial

Reset
ISDN Line

10baseT

INSTALLING the OverLAN ROUTER
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INSTALLING the OverLAN ROUTER

Task 2:  Connect your  router to a computer
(running terminal software) or to an ASCII
terminal.

Step 1:
Connect the supplied 9-pin end of an RS-232
communications cable.

Figure 4

Step 2:
Connect the other end of the cable into the COM port of a
computer (running terminal software) or to an ASCII
terminal -- see figure 4. If you are using the included
RJ-11-to-DB25 cable, a 25-9 pin adaptor may be needed for
the 25-pin end of the cable, if your computer has only a
9-pin port.

This completes Task 2.

In this task, you will configure the router from a local console port.
However, you may skip this task and configure the router using
OverLAN Commander from a Windows PC on the Ethernet.

Back of Router

RS-232 cable
(ex. RJ-11 to DB9-25)

Communications (Serial) Port

Computer or
ASCII terminal

Power
Reset 10base210baseT

BRI Port
(ISDN Line)
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Task 3:  Connect the router to a power source.

Step 1:
Connect the power cable, using the end with no prongs, into
the power socket on the back of the router -- see figure 5.

Figure 5

Step 2:
Connect the pronged end of the power cable into a standard
220 volts AC outlet -- see figure 5. The power light on the
front of the router should be on.

If your router is connected to the Ethernet through a
10BASE-T hub with a good-link light, be sure the light is
green (flashing or solid), indicating that your router is
properly connected to the hub.  Otherwise, before going on
to Task 4, refer to the section of this manual titled
TroubleShooting.

This completes Task 3.

INSTALLING the OverLAN ROUTER

Power socketBack of
Router

Power cable

Reset 10baseT Serial ISDN Line10base2
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Task 4:  Connect the router through an NT-1 into
the ISDN phone jack.

Step 1:
Connect one end of the RJ45 cable into the BRI port on the
back of the router -- see figure 6.

CAUTION:
Be careful that you DO NOT CONNECT this cable to
the 10BASE-T port shown in the 10BASE-T Method in
Task 1.

Figure 6

Step 2:
Connect the other end of the cable to the S/T interface on
the NT-1 -- see figure 6.

Task 4 is continued on the next page.

BRI Port
(ISDN Line)

INSTALLING the OverLAN ROUTER

Back of Router

RJ45 cable

connect to
S/T interface of NT-1Refer to the instructions

included with your NT-1,
an ISDN unit you purchase
separately

Reset 10baseT 10base2Power

NT-1
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Step 3:
Connect one end of another RJ45 cable to the U-interface
on the NT-1 -- see figure 7.

Figure 7

Step 4:
Connect the other end of the cable to the  ISDN phone jack
on the wall -- see figure 8.

This completes Task 4.

INSTALLING the OverLAN ROUTER

RJ45 cable

NT-1

Connect to
U-interface
of NT-1

ISDN phone jack

Rrefer to the instructions
included with your NT-1,
an ISDN unit you purchase
seperately.
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Configuring the
OverLAN Router
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Configuring the OverLAN Router

After installing the OverLAN router, you are ready to begin
configuration.  There are several methods you can choose
from to setup the router.

Method 1: OverLAN Setup Wizard
Application for Windows 95/NT that guides you through the
entire setup process in real-time.

Method 2: OverLAN Commander 32/IP
Application for Windows 95/NT that allows you to setup,
operate, and monitor OverLAN routers.

Method 3: OverLAN Commander 16/IPX
Application for Windows 3.xx and later that allows you to
setup, operate, and monitor OverLAN routers.

Method 4: OverLAN Operating System
Internal Program of the Router that allows you to setup,
operate, and monitor the OverLAN router from the local
console port of the router using an ASCII terminal or a
computer running terminal software.

CONFIGURING  YOUR ROUTER
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METHOD 1:  OverLAN Setup Wizard

Introduction
The OverLAN Setup Wizard is included in Version 1.45 and
later of OverLAN Commander 32/IP. To access the
OverLAN Setup Wizard, you must first install OverLAN
Commander 32/IP on a Windows 95/NT system with the
TCP/IP stack enabled.

To install OverLAN Commander 32/IP, do the following:

Step 1:
You should have two floppy disks for OverLAN
Commander.  Insert Disk 1 into floppy drive A: of your
Windows 95/NT computer.

Step 2:
Exit all applications currently open (or running) in Windows.

Step 3:
From Windows, select Start > Run and then run
A:\setup.exe.

Step 4:
Follow all of the online instructions for installing OverLAN
Commander.

When the installation of OverLAN Commander is complete,
you are ready to run the application.

Run OverLAN Commander
From Windows, select Start > Programs > OverLAN
Commander > Commander.  The OverLAN Commander
splash screen should appear followed by the OverLAN
Commander window (shown on the next page).

CONFIGURING  YOUR ROUTER
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OverLAN Commander Window

On the right-side of OverLAN Commander you may see a
list of routers.  Double-click on the name or icon for the
router you want to setup.

New routers (and routers moved to a different network than
originally setup for) will automatically display a Router
Initialization dialog box when selected.  Below is an
example of the Router Initialization dialog box.

Router Initialization Dialog Box

CONFIGURING  YOUR ROUTER
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You can also right-click on a router name from the list of
routers and then select Change IP Address to open the
Router Initialization dialog box.

Type in the IP Address that you want this router to have.
You should type the IP Address in the form of
xxx.xxx.xxx.xxx, where each xxx is a number ranging from
1 to 255.

Type in the Subnet Mask for the router.  You should type the
Subnet Mask in the form of xxx.xxx.xxx.xxx, where each
xxx is a number ranging from 1 to 255.

Once the router has been initialized, a properties dialog box
will appear, similar to the following.

    Properties Dialog Box

CONFIGURING  YOUR ROUTER
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At the same time that the Properties dialog box appears, all
of the menu bar and tool bar options in OverLAN
Commander will become available.

To start the OverLAN Setup Wizard, select the Setup

Wizard button  from the toolbar. The Setup Wizard will
then start and you should see the following dialog box.

OverLAN Setup Wizard
At this point, the Setup Wizard will begin to guide you
through each step of setting up the OverLAN router.  Follow
the online instructions in the Setup Wizard to complete
setting up your router.

This completes Method 1 of Configuring the OverLAN
Router.

CONFIGURING  YOUR ROUTER
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METHOD 2:  OverLAN Commander 32/IP

Introduction
OverLAN Commander 32/IP for Windows 95/NT is
provided on two 3.5-inch floppy disks with the OverLAN
Ethernet/ISDN router.

To use OverLAN Commander 32/IP for configuring and
maintaining your router, you will need a computer
(preferably equipped with a mouse) running Microsoft
Windows 95 or NT. Windows must be setup for TCP/IP and
the computer must be connected to your Ethernet network.

You should be familiar with using Microsoft Windows. If not,
please refer to the manual for that product.

The basic layout of OverLAN Commander is shown in the
figure below.

CONFIGURING  YOUR ROUTER
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To install OverLAN Commander 32/IP, do the following:

Step 1:
You should have two floppy disks for OverLAN
Commander.  Insert Disk 1 into floppy drive A: of your
Windows 95/NT computer.

Step 2:
Exit all applications currently open (or running) in Windows.

Step 3:
From Windows, select Start > Run and then run
A:\setup.exe.

Step 4:
Follow all of the online instructions for installing OverLAN
Commander.

When the installation of OverLAN Commander is complete,
you are ready to run the application.

Run OverLAN Commander
From Windows, select Start > Programs > OverLAN
Commander > Commander.  The OverLAN Commander
splash screen should appear followed by the OverLAN
Commander window (shown on the next page).

CONFIGURING  YOUR ROUTER
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CONFIGURING YOUR ROUTER

The right side of OverLAN Commander is used to show OverLAN
routers on the network.  Double-clicking on a router icon or name
opens a dialog box of the router’s properties.  Dialog boxes
showing  router properties appear on the left side of OverLAN
Commander.

The OverLAN routers can be displayed in one of four views.
Right-click on the right-side of OverLAN Commander for a
pop-up menu of different views.  The default view is Icon.

Right-clicking on the right-side of OverLAN Commander opens
the pop-up menu below (shown enlarged).

OverLAN Commander Window

If you right-click on a router icon or
name and select Open, you can
access router properties for the
selected router.
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CONFIGURING YOUR ROUTER

When router properties are accessed, a dialolg box appears on the
left-side of OverLAN Commander, as shown in the figure below.

The name of the router appears in the upper left corner of the
router properties dialog box.  This name corresponds to the name
beneath the router icon you select.

This completes the Introduction to OverLAN Commander for
Windows 95/NT.  The next section of the manual will cover how
to configuration an OverLAN router from OverLAN Commander.
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CONFIGURING YOUR ROUTER

Using OverLAN Commander 32/IP

To establish a communications link with a remote router or another
communications device, use the following instructions.

Disclaimer
Due to the varieties and complexities of networks and applications,
it is the responsibility of the network administrator to determine the
cost of all line charges, or any other charges which may be
incurred, resulting from the use of the OverLAN Ethernet/ISDN
router.  Such charges are not the responsibility of Ringdale.

Step 1:  Select a Router
Select a router from the Routers part of OverLAN Commander.  To
select a router you must double-click on the name or icon of the
router.  When a router has been selected, a dialog box of Router
Properties will appear.

Step 2:  Initialize the Router
If the selected router is a new router or if it has been moved onto a
another network recently, you may need to initialize the router.  If
the router requires initialization, a Router Initialization dialog box
will appear (shown below) instead of the Router Properties dialog
box.  Once initialized, the Router Properties dialog box will
appear.
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Step 3: Setup Router Properties
The router properties dialog box contains tabs that you can click on
to view and setup options for various router features.  This manual
will now present a detailed overview of the options and
information under each tab of router properties.

General Tab

Router Information

Router Information appears under the General Tab for the
properties for a router.

CONFIGURING YOUR ROUTER
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Connected Port:  This is the type of port (Ethernet, ISDN, or
Unknown) overwhich OverLAN Commander is communicating to
the router.  OverLAN Commander can monitor routers on Ethernet
ports regardless of whether any calls are active.  However, routers
on ISDN ports can only be monitored when calls are active to
those routers.
If a call to a router on an ISDN port is hung-up, OverLAN
Commander will not be able to monitor such a router. An
Unknown port is a port that OverLAN Commander simply cannot
determine.

Ethernet Address:  This is the Ethernet location, or MAC
address, of the selected router.

Firmware Version:  This is the version of firmware used by the
selected router.

Checksum:  This is the checksum of the firmware for the selected
router.  The word in parenthesis after the checksum indicates
whether the Flash EPROM or Permanent EPROM source of
firmware is being used.

Hardware Version:  This is the version of hardware for the
selected router.

Router Status:  This indicates the current operating status of the
selected router.  Active indicates the router is currently "visible" on
the network.  Inactive indicates the router is currently "not visible"
on the network.

Call Status

Call Status information appears under the General Tab for the
properties for a router.

CONFIGURING YOUR ROUTER
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CONFIGURING YOUR ROUTER

ISDN D-Channel represents a special channel normally used by
the router to transmit or receive signals for managing data transfers
over the ISDN line.
D-channel State Explanation
TEI Unassigned No IDENTITY assigned for ISDN network.
TEI Requested Router is asking for IDENTITY on ISDN network.
TEI Assigned Router has IDENTITY on ISDN network.
Starting Datalink Establishing datalink with phone switch.
Releasing Datalink Closing datalink with phone switch.
Datalink Active Datalink open with phone switch.

For routers using an ETSI or German switch type, the normal idle
state is when the D-channel state indicates TEI Assigned.  For
routers using the National ISDN 1 switch type, the normal idle
state is when the D-channel indicates Datalink Active.  When the
router is in the normal idle state for its switch type, this means that
it is in communication with the ISDN phone switch and is ready to
make calls.

ISDN B1 Channel and ISDN B2 Channel represent the physical
ISDN lines and the Point to Point Protocol. When a B-Channel is
active, then the ISDN line for that B-Channel is currently in use.
For data transfer to be possible on a B-channel, the channel status
must be active.

B-channel State Explanation
Unknown No response from router or unknown state.
No Call [State 0] No call is currently active.
Setup Sent [State 1] Call request sent.
Call Proceeding [state 3] Call is being established.
Alerting [State 4] Receiving status report from phone switch.
Call Received [State 8] A call is being received.
Call Active [State 10] Call is currently active.
Starting Attempting to establish a call.
Authentication Attempting security authorization.
Link Open Communications link is ready for transmission.
Link Down Communications link is not active.
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CONFIGURING YOUR ROUTER

Link Closed Communications link has closed.
Closing Communications link is being closed.
Stopped Communications link has been stopped.
Stopping Communications link is being stopped.
Request Sent Configuration request is being sent.
Ack Received Configuration accepted by remote device.
Ack Sent Accepting remote configuration request.
Disconnecting [State 11] A disconnect command has been received.
Releasing [State 19] Ending the call.

The B-channel states that do not end with a [state #] are part of
PPP (Point to Point Protocol).

Status Messages

Status Messages appears under the General Tab for the properties
for a router.

This area shows messages about the current operation of the
selected router.  These messages can be useful when
troubleshooting the router or ISDN line.
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CONFIGURING YOUR ROUTER

Connection Tab

Networking Options

Networking Options appears under the Connection Tab for the
properties for a router.  Based on how the selected router has been
setup, this area shows the resulting selections of Networking
Options (IPX, TCP/IP, and/or Bridging) being used for the current
connection.

PPP Options

PPP Options appears under the Connection Tab for the properties
for a router.  Based on how the selected router has been setup, this
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indicates the resulting selection of PPP Options being used for the
current connection.

Caller ID

Caller ID appears under the Connection Tab for the properties for a
router.  Based on how the selected router has been setup, this
indicates the resulting B-channel Caller ID states for the current
connection.

Tables Tab

NRIP Table

NRIP appears under the Table Tab for the properties for a router.

The NRIP table shows the IPX networks known to the selected
router.  These networks determine how IPX packets will be routed.

Location:  This is the location of the network, local or remote.
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CONFIGURING YOUR ROUTER

Network:  This is the Novell network.

Router:  This is the Ethernet, or MAC, address of the selected
router being used to reach the Novell Network.

Hops:  This is the number of routers or similar devices thru which
the network can be reached.

Time:  This is the internal Novell metric time it takes to get a
response from the selected network.

SAP Table

SAP appears under the Table Tab for the properties for a router.

The SAP table shows the servers and routers (known to the
selected router) that use IPX SAPs.  This table is used when
spoofing occurs and will determine what servers can be seen by the
selected router.
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Location:  This is the location on the network, local or remote, of
the service access point.

Type:  This is the type of service access point -- represented as a
hexadecimal number.

Network:  This is the network address of the selected SAP.

Name:  This is the network name of the device advertising the
selected SAP.

SAP Information:  This part of the SAP table shows decoded
information, if possible.  To decode a SAP Table entry, click once
on the Table entry you want decoded.  The decoded information
will then appear for the selected entry.

RIP Table

RIP appears under the Table Tab for the properties for a router.
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The RIP table shows the IP networks known to the selected router.
These networks determine how IP packets will be routed.

Location:  This is the location on the network (static, local/
dynamic, or remote) of the network.

Network:  This is the IP address of the network.

Subnet:  This is the subnet mask of the network..

Router:  This is the IP address of the router to reach this network.

RIP Information:  This part of the RIP table shows decoded
information, if possible.  To decode a RIP Table entry, click once
on the Table entry you want decoded.  The decoded information
will then appear for the selected entry.

ARP Table

ARP appears under the Table Tab for the properties for a router.
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The ARP table shows MAC addresses and their associated IP
addresses.  This table is used by the selected router when sending
IP packets.

Address:  This is the IP Address for a device.

Ethernet:  This is the Ethernet, or MAC, address of a device.

Time:  This is the time (in tens of seconds) before the entry is
deleted.

NAT Table

NAT appears under the Table Tab for the properties for a router.

The NAT table shows information on network IP address
translation.
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The NAT table is normally not available unless you select Show
Advanced Diagnostics for Routers from the Options dialog box
(see Options from the View Menu).

Protocol:  This is the protocol being translated.

Source Port:  This is the port of this connection.

Source IP Address:  This is the IP Address of the connection.

Key Port:  This is the new unique port of the connection.

Statistics Tab
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Ethernet Statistics

Ethernet Statistics appears under the Statistics Tab for the
properties for a router.

This part of the Statistics dialog box provides information on the
status of data currently being sent or received from the Ethernet.  If
no data is being transferred, then zero values will be indicated for
all communication parameters.  Because Ethernet data transfers
generally involve some degree of error handling, it is not
uncommon to see some errors reported.  However, if a high level
of errors are reported or if the count is increasing continuously
without stopping, you should consult with the Network
Administrator.

Framing Errors represents the number of incidents of corrupt
data resulting from framing errors on the Ethernet side of the
selected router.  Automatic error correction handles framing errors
for you.

CRC Errors represents the number of incidents of corrupt data
resulting from CRC errors on the Ethernet side of the selected
router.  Automatic error correction handles CRC errors for you.

Collisions represents the number of incidents of data transfer
collisions.  Collisions occur when someone else on the Ethernet
side of the selected router is already sending data at the time your
data transfer is expected.  Automatic error correction handles
collisions for you.

Missed Packets represents the number of packets not transferred
properly from the Ethernet network to the selected router.  These
errors often occur because the router is momentarily busy and
cannot receive data from the Ethernet network.  Automatic error
correction handles missed packets for you.
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ISDN Statistics

ISDN Statistics appears under the Statistics Tab for the properties
for a router.

This part of the Statistics dialog box provides information on the
status of data currently being sent or received from the ISDN line.
If no data is being transferred, then zero values will be indicated
for all communication parameters.  Because ISDN data transfers
generally involve some degree of error handling, it is not
uncommon to see some errors reported.  However, if a high level
of errors are reported or if the count is increasing continuously
without stopping, you may want to try hanging up and calling
again.  This is also true if the rate of data transfer is much lower
than expected.  Sometimes a data transfer problem can be as
simple as a bad connection in the phone switch.  So calling again is
always a good option.

The following categories apply to both Transmit and Receive
parameters.

Bytes/Second represents the number of bytes transferred each
second over the ISDN line.

Bytes/Second Trend represents a time-average bytes per second
transferred over the ISDN line.  The formula is ([bytes this sec] +
[bytes last sec])/2.

Packets/Second represents the number of packets transferred each
second over the ISDN line.

Packets/Second Trend represents the average packets per second
transferred over the ISDN line.
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Bandwidth Monitor

Bandwidth Monitor appears under the Statistics Tab for the
properties for a router.

Below is an example of the Bandwidth Monitor.

TX BPS represents Transmitted Bytes per Second which appears
as red line data in the Bandwidth Monitor.

RX BPS represents Received Bytes per Second which appears as
yellow line data in the Bandwidth Monitor.

The data in the monitor moves from right to left, the newest data
appearing on the right side of the monitor.  Each horizontal grid
mark represents approximately 5 seconds of elapsed time.

When there is no activity, a flat yellow line will be seen along the
bottom edge of the monitor.

When there is activity, transmitted and/or received data appears
above the bottom edge of the monitor.  The higher the data is
shown, the greater the percentage of the available bandwidth is
being used to handle the data transfer.  Each vertical grid mark
represents 25% of the available bandwidth.

The following table compares available bandwidth to the
percentages shown in the Bandwidth Monitor.
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Percentage of One B-channel Two B-channels
Bandwidth Used (Bytes/Second) (Bytes/Second)

0% 0 0
25%        2,000        4,000
50%        4,000        8,000
100%        8,000      16,000

Setup Tab

General Tab
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Router Name/Password

Router Name/Password appears under the Setup Tab > General
Tab for the properties for a router.

Router Name: Enter up to 10 letters and/or numbers for a name
for the selected router.  This name will appear in the upper-left
corner of Router Properties and in the Status Tab.  If more than one
router is installed, the name should reflect the location of the router
or the networks it is connecting.  No two routers should have the
same name.  The default for Router Name is based on the Ethernet
address of the router.

Password: Enter up to 10 letters and/or numbers for a password to
protect your configuration settings for the router.  To activate the
password you must also select the Password check box (in
Management Options).

Management Options

Management Options appears under the Setup Tab > General Tab
for the properties for a router.

Quiet Mode: Select this option to suppress status messages from
appearing on a local console connected to the router.  If a console
is not attached, Quiet Mode should be enabled.  When Quiet Mode
is disabled, messages about the status of the router appear on the
local console port. Regardless of whether Quiet Mode is on or off,
messages about the status of the system can always be viewed in
the Status Messages area of the Status Tab.

Password: Select this option to activate the Password.  This
password is entered in the Password entry field (in Router Name/
Password).  For the Password to be effective immediately, you



40

CONFIGURING YOUR ROUTER

must select the Save Setup button.  There after, anyone attempting
to access the router setup or configuration settings must first
provide a password.  In OverLAN Commander, the following
Password dialog box will appear.  You must type in the password
indicated in the Password field under Router Name/Password.  If
the field was left blank, then just select the OK button to continue.
Note that the password may appear blank if only spaces were typed
in for the password -- in which case you must type in spaces for the
Password dialog box.  The Password dialog box is shown below.

Disable Remote Management: Select this option to prevent
Remote Management.  Remote Management allows the selected
router to be managed from the remote site (the site you are calling
or are called by).  When Remote Management is allowed, the local
site is still able to manage the router.  But, it is recommended that a
router be managed by only one site.  If more than one site must be
used to manage a router, it is recommended that you exit OverLAN
Commander after each session is complete.  Disabling Remote
Management prohibits the remote site from managing the selected
router.

Protocol Options

Protocol Options appears under the Setup Tab > General Tab for
the properties for a router.
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To setup any type of routing, you must first enable one of the
options below.

Note: The protocol options setup here must be the same protocol
options setup for the device being called.  If, for instance, the
device being called is setup for IP Routing but not IPX Routing or
Bridging, then the selected router must also be setup for the same
options.  If not, then when a call is placed, the call will disconnect
during PPP negotiations.

Enable IP Routing: Select this option to allow the selected router
to route TCP/IP packets.

Enable IPX Routing: Select this option to allow the selected
router to route IPX packets.

Enable Bridging: Select this option to allow the selected router to
act as a bridge between two physical networks (the actual cables or
hubs which form a network).
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ISDN Tab

Router ISDN Information

Router ISDN Information appears under the Setup Tab > ISDN
Tab for the properties for a router.

ISDN phone numbers and ISDN SPID numbers are available from
the phone company.  For information about them, you will need to
contact the ISDN provider or the phone company.

Due to the varieties and complexities of networks and applications,
it is the responsibility of the network administrator to determine the
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cost of all line charges, or any other charges which may be
incurred, resulting from the use of the OverLAN Ethernet/ISDN
router.  Such charges are not the responsibility of Ringdale.

Local Switch Type: Select the type of ISDN phone service for the
location of the selected router.  For routers in the USA, select
National ISDN 1.  For routers in Germany, select ETSI (Variant).
For routers in other European countries, select ETSI.  For any
other country (or if you are unsure of the type of ISDN phone
service or the location of the selected router), use the default
setting for this option.  The default setting is ETSI.  If this option is
set incorrectly, the selected router may not be able to communicate
with the phone switch and, thus, may not be able to make or
receive calls.

Local Phone number (B1): Enter the ISDN phone number for the
selected router.  If the ISDN line for the router has two ISDN
phone numbers, type the phone number that corresponds to
channel B1 here.

SPID (B1): A SPID number may be needed if you set Local
Switch Type to National ISDN 1.  You should consult the ISDN
Provider to find out if a SPID number is required.  Type the ISDN
SPID number for the selected router.  If there are two ISDN SPID
numbers for the router, type the SPID number corresponding to
Router phone #1 here.

Local Phone Number (B2): If the selected router has only one
ISDN phone number, type that number again here.  If the selected
router has two ISDN numbers, type the second ISDN phone
number here.  Router phone #2 should correspond to channel B2.

SPID (B2): A SPID number may be needed if you set Local
Switch Type to National ISDN 1.  You should consult the ISDN
Provider to find out if a SPID number is required.  If the selected
router has only one ISDN SPID number, then type that number
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again here.  If the router has two ISDN SPID numbers, then type
the second number here.  SPID #2 should correspond to Router
phone #2.

Destination ISDN Information

Destination ISDN Information appears under the Setup Tab >
ISDN Tab for the properties for a router.  Double-click on a router
name to view router properties.

ISDN phone numbers and ISDN SPID numbers are available from
the phone company.  For information about them, you will need to
contact the ISDN provider or the phone company.

Due to the varieties and complexities of networks and applications,
it is the responsibility of the network administrator to determine the
cost of all line charges, or any other charges which may be
incurred, resulting from the use of the OverLAN Ethernet/ISDN
router.  Such charges are not the responsibility of Ringdale.

Phone Number #1: Enter the ISDN phone number for the device
you are calling.  If the ISDN line for the device you are calling has
two ISDN phone numbers, type the phone number corresponding
to channel B1 (of the remote device).

Phone Number #2: If the device you are calling has only one
ISDN phone number, type that number again here.  If the device
you are calling has two ISDN numbers, type the second ISDN
phone number here.  This number should correspond to channel B2
(of the remote device).
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PAP Setup

PAP Setup appears under the Setup Tab > PPP Tab for the
properties for a router.

Require PAP Authentication: Enabling Require PAP
Authentication makes the selected router use Unit Name and Unit
Password to determine access for routers or other devices calling
in.

PAP Unit Name and PAP Unit Password: This is the name and
password required by the selected router for remote devices calling
in.
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Unit Name and Unit Password should be no more than 10 letters
and/or numbers.  If one or both of these fields are left blank, then
the selected router will expect a blank ID and/or password from the
remote device.  If the remote device does not support PAP or does
not supply this exact name and password, the call will be rejected.

For OverLAN routers, the Peer Name and Peer Password for the
remote router must correspond to the Unit Name and Unit
Password for the selected router.

For routers or devices of other manufacturers, you must be sure
that the remote device settings correspond correctly with the
settings on the OverLAN router.  Refer to the instructions included
with the remote device for additional information.

Send PAP Authentication: Enabling Send PAP Authentication
makes the selected router transmit its Peer Name and Peer
Password to the remote router or device it is calling.  If Send PAP
Authentication is enabled and the remote device does not support
PAP, the remote device may hang-up the call or only give limited
access.

PAP Peer Name and PAP Peer Password: This is the name and
password to be supplied to the remote device.  Peer Name and Peer
Password should be no more than 10 letters and/or numbers.  If
one or both of these fields are left blank and Send PAP
Authentication is enabled, then the selected router will send a
blank ID and/or password to the remote device.

For OverLAN routers, the Peer Name and Peer Password for the
selected router must correspond to the Unit Name and Unit
Password for the remote router.

For routers or devices of other manufacturers, you must be sure
that the remote device settings correspond correctly with the
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settings on the OverLAN router.  Refer to the instructions included
with the remote device for additional information.

Multilink Setup

Multilink Setup appears under the Setup Tab > PPP Tab for the
properties for a router.

Enable Multilink: If selected, Enable Multilink allows the router
to use both B-channels simultaneously, which increases the speed
of the router but also increases the long distance line costs.  If
disabled, the router is limited to using only one B-channel, never
both channels simultaneously.

Minimum Fragment: The number in this field sets the minimum
size (in bytes) of data that can be fragmented during multilink
operations. The default and recommended value for this field is 0.
This feature may help in establishing compatibility with routers
made by other manufacturers.  In some cases, you may need to
contact Technical support at Ringdale (see the OverLAN user
manual) for help with certain types of routers or other devices.
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Call Setup Tab

General Call Setup

General Call Setup appears under the Setup Tab > Call Setup Tab
for the properties for a router.

Maximum Call Attempts: Type a number representing the
maximum number of calls the selected router should make to the
remote device when trying to establish a link.  For reasons such as
call collisions (when both devices try to call each other
simultaneously), some devices may not pick up on an initial call
but may pick up on a subsequent call.
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Call Type Setup

Due to the varieties and complexities of networks and applications,
it is the responsibility of the network administrator to determine the
cost of all line charges, or any other charges which may be
incurred, resulting from the use of the OverLAN Ethernet/ISDN
router.  Such charges are not the responsibility of Ringdale.

Call Type Setup appears under the Setup Tab > Call Setup Tab for
the properties for a router.

Call Mode: Select from options for Call by Command, Call on
Demand, and Permanent Channels.

Select Call by Command Only when you want calls to be manually
placed.  In this setup, the router cannot place calls automatically.

Select Call on Demand to have the router place calls automatically
when data is received for the remote network.

When one or both B-channels are selected as Permanent Channels,
then the selected channel(s) will remain open all of the time.  If an
error causes a disconnection, the router will automatically redial
the number and raise the line up again.

On Demand Call Timeout: Type a number representing the time
(in seconds) the selected router will keep a line up when there is no
activity while in Call on Demand mode.  A value of 0 will be
interpreted as infinity, which means a call will never timeout.  You
should determine the line charges in order to optimize On Demand
Call Timeout.

Allow Broadcasts to open an On Demand Channel: Enabling
this option allows On Demand Channels to be activated
automatically whenever general network broadcasts are received
by the router.
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Bandwidth on Demand Setup

Due to the varieties and complexities of networks and applications,
it is the responsibility of the network administrator to determine the
cost of all line charges, or any other charges which may be
incurred, resulting from the use of the OverLAN Ethernet/ISDN
router.  Such charges are not the responsibility of Ringdale.

Bandwidth on Demand Setup appears under the Setup Tab > Call
Setup Tab for the properties for a router.

Bandwidth On Demand: Bandwidth on Demand limits the use of
both B-channels to only when there is sufficient data to require
both channels. If this feature is disabled and the router is setup to
use both B-channels, then the router will use both channels
regardless of the amount of data being transferred.

Bandwidth Trigger: Type a number representing the bytes per
second of data going over the ISDN line at which point Bandwidth
on Demand should activate. The Bandwidth Trigger can be from 0
to 8,000 bps.  This option determines the point at which the router
will bring up the second B-channel for increased bandwidth.   The
default value is 0 (always using full bandwidth).

CONFIGURING YOUR ROUTER



51

IP Tab

IP Address Setup

IP Address Setup appears under the Setup Tab > IP Tab for the
properties for a router.

IP routing allows the selected router to route TCP/IP packets.  For
the IP Address and Subnet Mask, you should enter numbers in the
form of xxx.xxx.xxx.xxx, where each xxx
 is a number ranging from 1 to 255.

Router IP Address: Type the IP network address of the selected
router.  Also, select whether the router will allow a device it is
calling to assign it an IP address.  This option can be set to
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Negotiable or Fixed.  The suggested setting is Fixed, which does
not allow the IP address and Subnet mask to be assigned and
disconnects the call, if necessary.  The Negotiable setting allows an
IP address and Subnet mask to be assigned.

Router Subnet Mask: Type the IP network mask of the selected
router.

Default Gateway: Type an IP address of a router or other device
that the selected router can send packets to which have destinations
the selected router cannot determine by static routing tables or by
dynamic routing.

IP Options

IP Options appears under the Setup Tab > IP Tab for the properties
for a router.

IP routing allows the selected router to route TCP/IP packets.  For
the IP addresses, you should enter numbers in the form of
xxx.xxx.xxx.xxx, where each xxx is a number ranging from 1 to
255.
Remote IP Address Assignment: Select whether the router will
assign the remote address or not.  This option can be set to
Assigned or Fixed.  If Assigned, the Remote Address and Remote
Subnet Mask will be assigned to devices calling in and, for devices
not accepting the assignment, calls are disconnected.  If Fixed,  no
IP address or Subnet Mask is assigned to devices calling in.

Remote Address: IF Remote IP Address Assignment is set to
Fixed, then type the IP network address that the selected router can
assign to devices calling in.

ARP Configuration: Select Normal, RARP, Proxy, or RARP/
Proxy.
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Selecting Normal tells the router to operate without using RARP or
Proxy ARP.

Selecting RARP allows the selected router to dynamically petition
for an IP address and IP mask using RARP protocol if there is a
RARP server on the Ethernet network of the router.  The IP
address and subnet mask will automatically be assigned for the
router by the RARP server (regardless of whether they were
already assigned or not).

Selecting Proxy allows the selected router to handle the ARP
requests of devices on your Ethernet network that do not have a
static routing table or dynamic routing mode.

Selecting RARP/Proxy allows the router to operate using both
RARP and Proxy ARP, as described above.

RIP Configuration: Select No RIP, RIP, or RIP/Poison RIP.

Selecting NO RIP does not allow the router to operate using RIP.

Selecting RIP allows the selected router to use dynamic routing if
RIP is available on the Ethernet network of the router.

Selecting RIP/Poison RIP allows the router to operate using RIP
but adds Poison RIP capability too.  When the ISDN WAN
connection is not active, Poison RIP allows the router to advertise
that the remote network (via the ISDN phone numbers) is not
available.
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IP NAT Tab

Network Address Translation

Network Address Translation appears under the Setup Tab > IP
NAT Tab for the properties for a router.

Address Translation: Select from No Translation, 1 to 1 Static, 1
to 1 Dynamic, and 1 to Many. This feature allows the router to be
used with a low-cost Internet connection supporting dynamic IP
address assignment.  1 to 1 Static allows one computer on the local
network to have permanent access to the router (for the Internet,
for example). 1 to 1 Dynamic allows one computer at a time on the
local network has access to the router (for the Internet, for
example).  1 to Many allows many users on the local network
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simultaneous access to the router (for the Internet, for example)
using a single dynamic IP address.

NOTE: If 1 to 1 Dynamic is selected, the router must be locked by
the user before Internet access is permitted and released after
closing the connection.  Select lock or release from the toolbar, the
Router menu, or from a pop-up menu accessed by right-clicking on
the router name in the list of routers.

Static Client IP Address: If 1 to 1 Static IP Address Translation is
selected, then you must type the IP address of the computer or
device getting access to the router. Reset of the router is required
when enabling this option.

WAN IP Assignment: This needs to be setup if you selected either
1 to 1 Dynamic or 1 to Many.  Some ISPs (Internet Service
Providers) use dynamic IP address assignment for which a
different IP address can be assigned with each connection.  If this
is the case with your ISP, the option Assigned should be selected
with no Wan IP address entered.  Other ISP's use a fixed Wan IP
address dedicated to your account.  In this case, you should set the
Wan IP address option to Fixed and type in the dedicated Wan IP
address.

WAN IP Address: If WAN IP Assignment is set to Fixed
then you must enter the WAN IP Address here.
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IP NAT HOST Table Tab

IP Port Assignment Table

IP Port Assignment Table appears under the Setup Tab > IP NAT
Host Table Tab for the properties for a router.

When IP Address Translation is used, you can still support a
Website , FTP site, or other site on the Internet from your network
by setting up an IP Port Assignment Table.  Supply the IP Address
of the Webserver, FTP server, or other application server and type
in a Port number.
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In the case of a Webserver or FTP server, you can select the
standardized port number from the frop down list.  Select
HTTP(80) for a Webserver and select FTP(21) for an FTP server.

Select the Add button to add your entry to the IP Port Assignment
Table.

To remove an entry from the IP Port Assignment Table, click on
the table entry and select the Remove button.

IP Static Routes Tab
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Static Routing Table

Static Routing Table appears under the Setup Tab > IP Static
Routes Tab for the properties for a router.

You may want to create a static routing table if IP Routing is
enabled.  Static routing can be used with or without RIP. A static
routing table designates the exact route a packet will travel through
the network.

To setup an IP Static Route, double-click on an unused position in
the Network column of the Static routing Table and the following
dialog box will then appear.

IP addresses of the form xxx.xxx.xxx.xxx go in the first three
entries (Network Destination, Subnet Mask, and Gateway).  A
number of the form xxx goes in the fourth entry for Route Metric.
Each xxx represents a number in the range 1 and 255.

Network Destination: Type an IP address of a network that is
locally reachable by the selected router without it having to route
through ISDN.

Subnet Mask: Type the subnet mask that corresponds to the
network IP address (described above).
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Gateway: Type the IP address of the first router on the path a
packet will take to reach the network indicated for Network
Destination (described above).

Route Metric: Type the number of routers a packet will pass
through to arrive at the Network Destination (described above).

IP Filters Tab

IP Filter Table

IP Filter Table appears under the Setup Tab > IP Filters Tab for the
properties for a router.
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Current Address/Networks to Filter Out

This is a table of IP addresses that OverLAN Commander uses to
filter out packets coming from those addresses.  IP Addresses can
specify a single node or an entire network.  There are three
columns of information indicated in the table.  These columns are
described below.

Type:  This column indicates whether an Address (a specific node
of a network) or a Network (a range of addresses) is being filtered
out.

Address/Network:  This column indicates the IP Address being
filtered out.  If the IP Address ends in a zero, then the address
represents the local host address.

Subnet Mask:  This column indicates the Subnet Mask if the Type
column indicates a Network.  For a node specific address, this
column shows "---.---.---.---" for the Subnet Mask.

Address/Network to Filter Out

This section of the dialog box is where you specify IP Addresses to
be filtered out.

Type:  From the drop-down list, specify whether an Address (a
specific node of a network) or a Network (a range of addresses) is
to be filtered out.

Address/Network:  In this data field, specify the IP Address that
is to be filtered out.  Type the IP Address in the form of
xxx.xxx.xxx.xxx, where each xxx is a number ranging from 1 to
255.
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Subnet Mask:  This data field only appears if you select Network
for Type, described above.  In this data field, specify the Subnet
Mask.  Type the Subnet Mask in the form of xxx.xxx.xxx.xxx,
where each xxx is a number ranging from 1 to 255.  For a node
specific address, this column shows "---.---.---.---" for the Subnet
Mask.

Add Button:  Select the Add button to add the currently selected
address or network to the table of addresses and networks to filter
out.

Remove Button:  If you click on an item in the Type column of
the table (described above) and then select the Remove button, the
item will be removed from the table of IP Addresses to filter out.
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IPX Tab

IPX Address

Due to the varieties and complexities of networks and applications,
it is the responsibility of the network administrator to determine the
cost of all line charges, or any other charges which may be
incurred, resulting from the use of the OverLAN Ethernet/ISDN
router.  Such charges are not the responsibility of Ringdale.

IPX Address appears under the Setup Tab > IPX Tab for the
properties for a router.

IPX routing allows the selected router to route Novell IPX packets.
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IPX Network Address: Type an 8 digit IPX address of the form
xxxxxxxx, where each x is a hexadecimal number from 0-9 or A-F.
This is IPX network address of the router. The network address
will be bound to the frame type selected below.

Frame Type: From the drop-down list select the frame type,
whichever is the frame type used for the Ethernet network of the
router. If there is a Novell server on the Ethernet network, the
frame type is the same frame type that the Novell server uses. The
network address entered above will be bound to the frame type
selected.  The OverLAN ISDN router supports Ethernet II,
Ethernet 802.3, Ethernet SNAP, and Ethernet 802.2 frame types.

IPX Routing Options

Due to the varieties and complexities of networks and applications,
it is the responsibility of the network administrator to determine the
cost of all line charges, or any other charges which may be
incurred, resulting from the use of the OverLAN Ethernet/ISDN
router.  Such charges are not the responsibility of Ringdale.

IPX Routing Options appears under the Setup Tab > IPX Tab for
the properties for a router.

Novell Rip Spoofing: This form of spoofing helps prevent a phone
line from being raised when RIP packets from Novell servers
advertising networks are encountered. This feature can help save
on long distance line charges.

Watchdog Spoofing: This form of spoofing helps prevent a phone
line from being raised when Watchdog packets from Novell servers
checking on client connections are encountered. This feature can
help save on long distance line charges.
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SAP Spoofing: This form of spoofing helps prevent a phone line
from being raised when SAP packets from Novell servers are
encountered. This feature can help save on long distance line
charges.

Bridging Tab

Ethernet II Filtering Options

Ethernet II Filtering Options appears under the Setup Tab >
Bridging Tab for the properties for a router.

Select any filters you want the selected router to use while
bridging.
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Disable IPX:  Select this option to prevent IPX packets from
crossing the bridge.

Disable IP:  Select this option to prevent IP packets from crossing
the bridge.

Disable NetBEUI:  Select this option to prevent NetBEUI packets
from crossing the bridge.

Disable AppleTalk:  Select this option to prevent AppleTalk
packets from crossing the bridge.

Disable Others:  Select this option to prevent packets other than
IPX, IP, NetBEUI, and AppleTalk from crossing the bridge.
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Advanced Diagnostics Tab

ISDN Information

ISDN Information appears under the Advanced Diagnostics Tab
for the properties for a router.

In the Advanced Diagnostics Tab, diagnostic information about the
ISDN lines is displayed under the heading ISDN Information.

The Advanced Diagnostics dialog box appears if the option for
Show Advanced Diagnostics for Routers is selected from the
Options dialog box.
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From the View Menu, you can select Options.  When selected, the
Options dialog box will appear.

This topic describes the Options dialog box (shown below).

Additional Addresses to Monitor
This section of the dialog box is where you specify IP Addresses of
remote devices (such as other OverLAN routers) that you want to
monitor with OverLAN Commander.  You can force OverLAN
Commander to refresh the router list by right clicking on the area
for listing routers and then selecting Poll for Routers.

IP Address:  In this data field, specify the IP Address of the
device that is to be monitored.  Type the IP Address in the form of
xxx.xxx.xxx.xxx, where each xxx is a number ranging from 1 to
255.

CONFIGURING YOUR ROUTER



68

Add Button:  Select this button to add the specified address from
the IP Address data field above to the list of Additional Addresses
to Monitor.

Delete Button:  Select this button to remove an address from the
list of Additional Addresses to Monitor.  Click on an address in the
list and then select this button to delete the address from the list.

Allow the main flash to be upgraded
Select this option to allow the main flash EEPROM of the router to
be upgraded with new firmware.  For more information, see
Upgrade Router.

Show Advanced Diagnostics for Routers
Select this option to enable a line diagnostics troubleshooting tool
in OverLAN Commander.  Once enabled, close the Router.
Properties dialog box.  Then, reselect the router.  When reselected,
the Router Properties dialog box will include tabs for Advanced
Diagnostics and ISDN Trace.  These features are provided
primarily to help Technical Support at Ringdale to determine the
operating condition of the router.

Re-transmission Timeout (Sec)
This is the time in seconds that the router will wait for a response
from the device it is calling before attempting to re-transmitt to the
device.  Generally, 1 second should be sufficient for most devices.
However, sometimes a setting of 2 seconds can help to compensate
for a congested network or a slow device.  In extreme cases, even
3 or 4 seconds could be necessary.  If you must set this option to
more than 4 seconds, you may want to inquire to the associated
Network Administrator, ISDN Provider, or telephone company
about whether or not there is an excessively congested ISDN
phone switch or some other similar kind of problem that needs
attention.
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Maximum number of Re-transmissions
This is the maximum number of times that the router will re-
transmitt to the device being called after getting no response from
the device before giving up.  Generally, 15 retries should be
sufficient for most devices and networks.  However, a larger
number of retries could be necessary to compensate for congested
networks or slow devices.  How you set this option depends
somewhat on how you set the RE-Transmission Timeout setting
above.  Generally, if the Re-Transmission Timeout is set to 1 or 2
seconds, then you would likely not need to set this option to any
more than 30 retires -- beyond which there may be a problem that
needs attention (as described under Re-Transmission Timeout
above).  This option can in fact be set to as high as 99 retires.
However, such a setting is far in excess of what would be
considered the norm.  Consider, for instance, that with just a 1
second timeout and 30 retries, the user might wait a total of a half a
minute while the router attempts to get a response from the remote
device.

Show Splash Screen upon Program Execution
This option (when checked) enables the Splash Screen to appear
on the screen as the program is initiating execution.  Uncheck this
option to disable to splash screen.
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ISDN Trace Tab

Diagnostic Trace

Diagnostic Trace appears under the ISDN Trace Tab for the
properties for a router.

The trace is displayed under the heading Diagnostic Trace.  The
codes shown in the trace are then translated and the translations
appear in the Message Decode section of the ISDN Trace Tab.
Message Decode

Message Decode appears under the ISDN Trace Tab for the
properties for a router.
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The trace codes are decoded into plain English messages that are
displayed under the heading Message Codes.

Save Trace: Select the Save Trace button to save a trace as a text
file so that it can be viewed or printed from a text editor.

Reset:  Select the Reset button to clear the current trace and start
over.

Step 4: Save Settings
When you are satisfied with the router settings you have setup,
select the Save Setup button to install the settings on the router.  If
you do not select the Save Setup button, your settings will be lost
when you exit from OverLAN Commander.

Step 5: Verify Settings
View the General Tab and the Statistics Tab sections of OverLAN
Commander and verify that the router is operating correctly. If you
suspect that the router is not operating correctly, consult with the
network administrator or the ISDN provider.  To redo the router
setup, go back to Step 1. Be sure to select this router again.

Step 6: Perform Loopback Test
Select the Loopback Test from the Router Menu or from the
toolbar.  If any error messages are reported in the Status Messages
area, consult with your network administrator or the ISDN
provider.  You should also refer to the manual that is included in
the router package. If no error messages are reported, go to Step 6.

Step 7: Establishing Communications Link
Place a call by selecting Quick Call from the menu options or
from the toolbar.  If the router has trouble establishing a
communications link, consult with the network administrator or the
ISDN provider and refer to the manual that is included in the
router package.
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Step 8: Observe Status Messages
If the router appears to successfully place the call, observe the
messages under Status Messages in the General Tab. Also look at
the Statistics Tab section.  If anything appears to be wrong, consult
the network administrator or the ISDN provider and refer to the
manual included in the router package.  You can also look at the
Tables Tab for specific feedback from the router about NRIP, SAP,
RIP, ARP, and NAT routing information.

Step 9: Hanging-up Calls
You can hang-up the call by selecting Hangup or, depending on
how you setup the router, the router may hang-up by itself.

Step 10: Exiting OverLAN Commander
Select Exit from the file menu to quit the current session of
OverLAN Commander.  Remember, for any configuration changes
to affect the router, you must save changes to the router (Save
Setup).

Note:  You can also setup and manage the router from its local
console port.  The router's built in OverLAN Operating System has
similar functionality to OverLAN Commander but can only be
used locally with the router (not across the network) and it only has
a text menu interface -- a local console for the router can be very
useful such as when your network or the network of the router is
not operating correctly.
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CONFIGURING YOUR ROUTER

Setup: OverLAN Commander for Windows 3.xx

Introduction

OverLAN Commander is available on a 3.5-inch floppy disk
included with your Ethernet/ISDN router package.

To use OverLAN Commander 16/IPX for configuring your
router, you will need a computer (preferably equipped with a
 mouse) running Microsoft Windows (version 3.11 or
greater).  The computer must be connected to your Ethernet
network.

You should be familiar with using Microsoft Windows. If not,
please refer to the manual for that product.

There are three dialog buttons you should be familiar with
before using OverLAN Commander.

Common buttons:

for helpful hints and instructions

to quit the current dialog box and leave all settings
unchanged

to quit the current dialog box and record all changes made
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Task 1: Go to the Setup dialog box

The main dialog box for OverLAN Commander appears
when the application is started, as shown below:

Main Dialog Box

Step 1: Select the router for Setup

The default name of all routers on your network will appear
in the main dialog box.  It may take a few seconds for the
router name to appear.

Using your computer’s mouse, click on the name of the
router you want to set up.  The router name should become
highlighted, meaning the router is selected.

CONFIGURING YOUR ROUTER
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Step 2:  Select                        from the main dialog
   box

The main dialog box is shown on the previous page.

Using the mouse, click on Setup Router.  The main dialog
box will disappear from the video display and the Setup
dialog box will appear.

NOTE:    If you select Setup Router before selecting a
router in Step 1, the following error message will appear:

           Error Message

Should you make this mistake, simply click on
and re-follow Step 1.

CONFIGURING YOUR ROUTER
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The Setup dialog box appears after a few moments, as shown
below:

           Setup Dialog Box

The Setup dialog box is divided into five primary areas:

1. Unit Information (upper-left corner).
2. ISDN/PPP Setup (lower-left).
3. Routing Options (upper-right corner).
4. Call Control (lower-right).
5. A series of five buttons (the bottom edge).

From the Setup dialog box, you will perform several tasks
corresponding to the five above areas.

The router supports various international protocols,
therefore, enabling data tranmission worldwide. This facility
is selected by choosing the correct protocol from the
Telephone Co. box.

CONFIGURING YOUR ROUTER
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Task 2: Select the Unit Information

Step 1:  Select a Unit Name

              From the Setup dialog box

Unit Name appears under Unit Information, shown above.
This is the router name that appears in the OverLAN
Commander main menu.  If more than one router is
installed, the name should reflect the location of the router
or the networks it is connecting.  No two routers should
have the same name.

Unit Name should already have a default name.  If you want
to keep this name then you can go to Step 2.

Otherwise, erase the default Unit Name and type in a new
name of up to 10 letters and/or numbers.

You have set the Unit Name.

Step 2:  Select a Console Password.

Console Password appears under Unit Information, above.
It is used to protect your configuration settings.

CONFIGURING YOUR ROUTER
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Console Password is a password of up to 10 letters and/or
numbers and will protect your configuration settings.

The default for Console Password is off.  To turn on this
feature, use the mouse to click on the small gray square next
to Console Password.

Console Password is active when the little grey square next
to Console Password above has a check mark in it, like the
following:

Step 3:  Select Quiet Mode to be on or off.

From the Setup dialog box

The default for Quiet Mode is on.  This suppresses status
messages from appearing on a local console port connected
to the router.  If a console is not attached, leave Quiet Mode
enabled.

When Quiet Mode is off, messages about the status of the
router appear on a local console port .

Regardless of whether Quiet Mode is on or off, messages
about the status of the system will always be accessible from
OverLAN Commander.
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To turn on Quiet Mode, use the mouse to click on the small
gray square next to the words Quiet Mode.  A          should
appear.

Step 4:  Select Remote Management to be on or off.

Remote Management appears in Unit Information, shown on
the previous page.

Remote Management allows the selected router to be
managed from the remote site (the site you are calling or are
called by).  When remote management is allowed, the local
site is still able to manage the router.  If more than one site
must be used to manage a router, it is recommended that you
exit OverLAN Commander after each session is complete.

To activate Remote Management, use the mouse to click on
 the small gray square next to the words Remote
Management.  A          should appear.

You have finished configuring the Unit Information.

CONFIGURING YOUR ROUTER
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Task 3: Set up the ISDN/PPP Parameters:

The ISDN Parameters are shown below:

From the Setup dialog box

Step 1: Select the Telephone Co.

This is the type of ISDN phone service for the location of the
selected router.  For routers in the USA, select National
ISDN 1. For routers in Germany, select ETSI Variant.  For
routers in other European countries, select ETSI.  For any
other country (or if you are unsure of the type of ISDN phone
service or of the location of the selected router), use the
default setting for this option.  The default setting is ETSI.
If this option is set incorrectly, the selected router may not be
able to communicate with the phone switch and thus, may
not be able to make or receive calls.

Step 2: Enter Router Phone #1.

Type the ISDN phone number of the selected router.  Some
ISDN lines have two phone numbers.  If this is the case, type
the number corresponding to channel B1 here.

NOTE:   ISDN Phone numbers and ISDN SPID numbers are
available from the phone company.  For more information about
them, you will need to contact your ISDN provider.
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Step 3: Enter Router Phone #2.

If the selected router has only one phone number, then type
that number again here.

But, if the selected router has two phone numbers, then type
the number corresponding to channel B2 here.

Step 4: Enter Phone Number #1.

Type the ISDN phone number of the router you are calling.

Some ISDN lines have two phone numbers.  If this is the
case, type the number corresponding to channel B1 here.

Step 5: Enter Phone Number #2.

If the remote router has only one phone number, then type
that number again here.

But, if the remote router has two phone numbers, then type
the number corresponding to channel B2 here.

Step 6:  Enter SPID #1.

If you selected National ISDN 1 for Telephone Co. and the
selected router has a SPID (provided by the phone company),
type the SPID number here.

If you acquired two ISDN SPID numbers for the selected
router, type the SPID corresponding to channel B1.

Step 7:  Enter SPID #2.

If the selected router has only one ISDN SPID number, type
that same number again here.

But, if the selected router has two ISDN SPID numbers, type
the number corresponding to channel B2 here.
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Setting up Point to Point Protocol

Point to Point Protocol options are shown below:

PPP Setup dialog box

Step 8:  Setup Require PAP Authentication.

The default of Require PAP Authentication is off.

Require PAP Authentication: Enabling Require PAP
Authentication makes the selected router use Unit Name and
Unit Password to determine access for routers or other
devices calling in.

PAP Unit Name and PAP Unit Password: This is the name
and password required by the selected router for remote
devices calling in.  Unit Name and Unit Password should be
no more than 10 letters and/or numbers.  If one or both of
these fields are left blank, then the selected router will expect
a blank ID and/or password from the remote device.  If the
remote device does not support PAP or does not supply this
exact name and password, the call will be rejected.
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For OverLAN routers, the Peer Name and Peer Password for
the remote router must correspond to the Unit Name and
Unit Password for the selected router.

For routers or devices of other manufacturers, you must be
sure that the remote device settings correspond correctly with
the settings on the OverLAN router.  Refer to the instructions
included with the remote device for additional information.

Step 9:  Setup Send PAP Authentication.

The default of Send PAP Authentication is off.

Send PAP Authentication: Enabling Send PAP
Authentication makes the selected router transmit its Peer
Name and Peer Password to the remote router or device it is
calling.  If Send PAP Authentication is enabled and the
remote device does not support PAP, the remote device may
hang-up the call or only give limited access.

PAP Peer Name and PAP Peer Password: This is the name
and password to be supplied to the remote device.  Peer
Name and Peer Password should be no more than 10 letters
and/or numbers.  If one or both of these fields are left blank
and Send PAP Authentication is enabled, then the selected
router will send a blank ID and/or password to the remote
device.

For OverLAN routers, the Peer Name and Peer Password for
the selected router must correspond to the Unit Name and
Unit Password for the remote router.

For routers or devices of other manufacturers, you must be
sure that the remote device settings correspond correctly with
the settings on the OverLAN router.  Refer to the instructions
included with the remote device for additional information.

CONFIGURING YOUR ROUTER
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CONFIGURING YOUR ROUTER

Step 10:  Select Multilink PPP to be on or off.

The default of Multilink PPP is off.

If Multilink PPP is off, the router is limited to using only one
B-channel, never both channels simultaneously.

If Multilink PPP is on, the router may use both B-channels
simultaneously, which increases the speed of the router but
also increases long distance line costs.

Type a number for the Fragment Size.  This number
represents  the minimum size of data (in bytes) that can be
fragmented during multilink operations.  The defualt and
recommended value for this field is 0.
Step 11:  Setup IP Assignment Options.

For Local IP Assignment, the default and recommended
value is Negotiable, which allows an IP address to be
assigned to the selected router by the remote device, if
necessary.  Fixed does not allow an IP address to be
assigned.

For Remote IP Address, select to enable/disable this option.
If enabled, the selected router will assign the IP address
(from the field next to the check box) to any remote device
calling in.  If a remote device will not accept the assignment,
that device will not gain access to the router.  The IP address
should be a number in the form of xxx.xxx.xxx.xxx, where
each xxx is a number ranging from 1 to 255.

You have finished configuring the Point to Point Protocol.
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Setting up Call Control

Step 12: Select Call on Demand or Call by
  Command.

From the Setup dialog box

Call Method:

By Command is recommended if your router will have
only a single user.   This option gives you complete control
over the ISDN connection.

On Demand instructs the router to place the call
automatically when data is received for the remote network.
You can select On Demand for channel B1 or B2 or both
channels B1 and B2.

Permanent instructs the router to place and maintain the call
automatically regardless of whether there is data for the
remote network. You can select Permanent for channel B1 or
B2 or both channels B1 and B2.

If Call on Demand is enabled, you must also setup Call
Timeout.  Type in the number of seconds the selected router
will keep a line up when there is no activity.  A value of 0
will be interpreted as infinity, which means a call will never
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CONFIGURING YOUR ROUTER

timeout.  You should determine the line charges in order to
optimize Call Timeout.

Step 13: Select Bandwidth on Demand (BOD) to be
on or off.

Bandwidth on Demand limits the use of both B-channels to
only when there is sufficient data to require both channels.
If this feature is turned off and your router is setup to use
both B-channels, then both channels will be used regardless
of the amount of data.

The BOD Level (BPS) can be between 1 - 64,000 bps. The
BOD Level must be set if Bandwidth on Demand is turned
on. This determines the point where both channels will be
activated by the router.  You must decide what this number
should be, based on the ISDN connect charges and the cost
of long distance line charges.

Enter the BOD Time (SEC), which is the time in seconds
that the selected router will allow the second B-channel to
remain up when there is insufficient data transferring before
bringing the channel down again.  When setting this feature,
you should determine the line charges in you area in order to
optimize BOD Time.

Step 14: Set Max Call Attempts.

Type in a number for Max Call Attempts, which is the
maximum number of calls the selected router should make to
the remote router when trying to establish a link.  For reasons
such as call collisions (when both routers try to call each
other simultaneously), some routers may not pick up on an
initial call but may pick up on a subsequent call.
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Step 15: Select Line Idle Detection to be on or off.

Select Line Idle Detection if the device being called is an
OverLAN router (or another type of router that is compatible
with Line Idle Detection).  This option allows the selected
router to detect certain disruptions in the communications
link with the remote device and hangup.  If you are not sure
whether the remote device supports Line Idle Detection,
disable this option.

You have finished configuring the ISDN/PPP parameters.

Task 4:  Set up the Routing Options

You should determine the types of packets that will be
routed.  Ask the Network Administrator if you are unsure.
The options from the Setup dialog box appear below:

From the Setup dialog box

At least one of the three routing options must be turned on,
but they may be used in any combination you choose.

Step 1: Select Bridge to be on or off.

The default for Bridge is off.

CONFIGURING YOUR ROUTER
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CONFIGURING YOUR ROUTER

When Bridge is on, indicated by          next to Bridge, you
can setup your router to act as a bridge between two
physical networks.

To configure Bridging, use the mouse and click on

The Bridge Setup dialog box is shown below:

Bridge Setup dialog box

The filters only work for Ethernet II frame types. Other
frame types such as Ethernet 802.3 cannot use the filters,
but the router can still act as a bridge.  It just will not be able
to use filters in that situation. Choose any of the filters
individually or in combination.

Choices:

• Filter IPX prevents IPX packets from crossing the
bridge.

• Filter IP prevents IP packets from crossing the bridge.
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• Filter NetBEUI prevents NetBEUI packets from
crossing the bridge.

• Filter AppleTalk prevents AppleTalk packets from
crossing the bridge.

• Filter Others prevents packets other than IPX, IP,
NetBEUI, and AppleTalk from crossing the bridge.

You have finished configuring Bridging.

Step 2: Select Route IP Traffic to be on or off.

The default for Route IP Traffic is off.

Route IP Traffic allows your router to route TCP/IP packets.

To configure IP routing, use the mouse and click on

The IP Router Setup dialog box is shown below:

IP Router Setup dialog box

CONFIGURING YOUR ROUTER



90

CONFIGURING YOUR ROUTER

For IP Address and Subnet Mask, type in numbers in the form of
 _ _ _ . _ _ _ . _ _ _ . _ _ _, where each _ _ _ is a number ranging from
001 to 255.

IP Address is the IP network address of your router.
Subnet Mask is the IP network mask of your router.  There
are five choices for IP routing that may be used individually
or in combination.  These choices are available if you are
routing beyond your local network.

The defaults for these options are turned off, or disabled.

Choices:

• Enable RARP allows the router to dynamically petition
for an IP address and IP mask using RARP protocol if
there is a RARP server on the Ethernet network.  In
other words,  the IP Address and Subnet Mask will
automatically be as signed for the router by the RARP
server (regardless of whether they were already assigned
or not for Unit Designation).

• Enable Default Gateway allows the IP address for
Default Gateway to be used by the router for handling
IP packets with destinations that cannot be determined
by static routing tables or by dynamic routing.

The Default Gateway address is an IP address of a
router or device that the selected router can send
packets to which have destinations it cannot
determine by static routing tables or by dynamic
routing.

• Enable Proxy ARP allows the selected router to handle
the ARP requests of devices on the Ethernet network
that do not have a static routing table or dynamic routing
mode.
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• Enable RIP allows the selected router to use dynamic
routing if RIP is available on the Ethernet network.

• Enable Poison RIP is only available if you turned on
Enable RIP.  Enable Poison RIP is used if you want the
router to advertise that the remote network (selected
earlier in Task 3) is not available when the ISDN WAN
connection is not active.

Step 3: Setup a Static Routing Table.

You may want to create a Static Routing Table if IP Routing
is enabled. Static routing can be used in conjunction with
RIP.

Choose

The Static Routing Table is shown below:

Static Routing Table dialog box
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IP addresses of the form _ _ _ . _ _ _ . _ _ _ . _ _ _ go under the first three
columns for Network, Subnet Mask, and Router.  A number of the form
_ _ _ goes in the fourth column for Hops.  Each _ _ _ is a number
ranging from 001 and 255.

A Static Routing Table is used to designate the exact route a
packet will travel through the network.

The column for Network is for a network that is reachable
locally by the selected router without it having to route
through ISDN.

The column for Subnet Mask is for a subnet mask
corresponding to the above network.

The column for Router is for the first router on the path a
packet will take to reach the network described above.

The column for Hops represents how many routers a packet
will pass through to arrive at the network described above.

Once you’ve made a Static Routing Table, you are ready to
go to Step 4.

Step 4: Select Route IPX Traffic to be on or off.

The default of Route IPX Traffic is off.

Route IPX Traffic allows your router to route Novell IPX
packets.

To configure IPX routing, use the mouse and click on

CONFIGURING YOUR ROUTER
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The IPX Setup dialog box is shown below:

IPX Setup dialog box

For Network, type in an 8-digit IPX address of the form _ _ _ _ _ _ _ _,
where each  _  is a hexadecimal number from 0 - 9 or A - F.  This is your
network address.

There are three choices for IPX Spoofing that can be used
individually or in combination.

The defaults for these spoofing options are on.

Choices:

• Novell RIP Spoofing helps prevent a phone line from
being raised when RIP packets from Novell servers
advertising networks are encountered.  This feature
can help save on long distance line charges.

• Watchdog Spoofing helps prevent a phone line from
being raised when Watchdog  packets from Novell servers
checking on client connections are encountered.  This
feature can help save on long distance line charges.
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• SAP Spoofing helps prevent a phone line from being
raised when SAP packets from Novell servers
advertising other Novell servers are encountered. This
feature can help save on long distance line charges.

NOTE: Due to the varieties and complexities of networks and
applications, it is the responsibility of the network administrator,
and not that of Ringdale., to determine the cost of all line charges, or
any other charges which may be incurred, resulting from the use of
the OverLAN Ethernet/ISDN router.  Such charges are not the
responsibility of Ringdale.

You must also declare the Frame Type, which  is the type of
Ethernet frame used for your Ethernet network.  If you
have a Novell server on your Ethernet network, the frame
type will be the same frame type as the Novell server uses.

The choices for frame type include Ethernet II, 802.2, SNAP,
and 802.3

You have finished configuring the Routing Options.
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Task 5: Saving your configuration settings

At the bottom edge of the Setup dialog box, are the following
buttons:

From Setup dialog box

Select:

to save your configuration settings in the router.

Save Setup must be selected for the new parameters to be
preserved. Otherwise, if power is ever removed from the
router, the parameters will be lost.

After saving, you will automatically be returned to the main
dialog box.  There may be a few seconds delay before the
main dialog box appears.

CONFIGURING YOUR ROUTER
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Configuring with a
Local Console
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Configuring with a Local Console
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CONFIGURING WITH A  LOCAL CONSOLE

Task 1: Getting to the Setup Menu

The router must first be connected to an ASCII terminal or
a computer running terminal software (shown in Task 2 of
Installing Your Router).

When you plug the router into a power source (shown in
Task 3 of Installing Your Router), the video display of the
computer or ASCII terminal should show the following
message for a few moments:

OverLAN System Initializing (please wait).....

The above message is temporary and will be replaced with
the message shown in figure 8.
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Configuring with a Local Console

The second message that appears on the video display is the
title message and below the title message is a command
prompt.

Figure 8           Command prompt (The
          spaces indicated before the
          colon represent the router
          name.)

By typing ? and pressing the Enter key, a list will appear on
the video display of the commands you can use.

Type ? and press the Enter key to see the commands.

The list of commands are shown in figure 9 on the next page.

O v e r L A N
Operating System        1.47

[Enter ? for list of options.]

- - - - :



100

CONFIGURING WITH A LOCAL CONSOLE

Figure 9

To use one of these commands:
Type the word for the command from the left column of the above list
or the abbreviation given in brackets from the middle column. When
you have completed typing the command, press the Enter key.

To configure your router, you should use the SETUP
command, which gives you the SETUP menu.

To select this command, do the following:

Type SETUP or SU from the menu above and press the
Enter key.

The SETUP menu is shown in figure 10.

O v e r L A N
Operating System        1.47
[unit designation]: ?
Command Options
------------------------------------------------------------------
CALL x [Cx] - Call ISDN Channel x.
CLOSE [CL] - Disconnect ISDN Channel.
RESET [RE] - Restart the OverLAN Unit.
SETUP [SU] - Enter OverLAN Setup Menu.
SYSOP [SY] - Enter OverLAN System Options Menu.
HELP [?] - Displays this message.

Router Status Commands:

STATUS [ST] - System Status.
STATS [SS] - Router Statistics.
NRIP [NR] - Novell Routing Info.
SAP [SP] - Novell SAP Info.
RIP [RP] - IP Routing Info.
ARP [AR] - ARP cache.
FILTER [FI] - Current MAC filters.
[unit designation]:
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Figure 10

To make a selection from the Setup menu, press the number
or letter appearing in the left column of the menu above.
You will not have to press the Enter key, your selection will
automatically be read by the computer.

You can always change a selection by selecting the option
again, and you can always go back to the Setup menu
whenever you want.

Selection 1 represents features for the operating system.

Whenever you are setting up features, an asterick (*) means
the unit must be reset for changes to take effect.

Turn the page for instructions on configuring the operating
system.

CONFIGURING WITH A LOCAL CONSOLE

O v e r L A N
Setup menu

1. - Operating System
2. - ISDN Manager
3. - PPP Manager
4. - IP Protocol
5. - IPX Protocol
6. - BRIDGING

7. - Static IP Routing Table
8. - Filter Table
9. - Host Table

S - Save Setup and Exit
X - Exit without Saving

Selection:
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Task 2: Configuring the Operating System

From the Setup Menu,

Press 1

to configure the router’s operating system.

The prompt
Unit Designation  :

will appear at the bottom of the video display.

The default of Unit Designation is a unique name based on
the router’s unique Ethernet network address.  This will be
a series of numbers, or letters, appearing after the colon
above.

Choices:

• Type a new name for your router of up to ten letters
and/or numbers.

This name will appear in the Command Prompt and as the
router name in OverLAN Commander..

• Leave the current setting unchanged by not typing
anything.

Press the Enter key when you are ready to continue.
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The prompt
Unit Password  :

will appear beneath the previous prompt.

Choices:

• Type a password for your router of up to ten letters and/or
numbers.

The password will protect your configuration settings, but
you must set the Console Password option to Required
for the password to be activated.

• Do one of the following:
• Leave this feature unchanged, even if it is

blank, by not typing anything.
• Erase the current password with the back

space key and leave the feature blank or
type a new password.

Leaving this feature blank effectively turns the feature off.

Press the Enter key when you are ready to continue.

CONFIGURING WITH A LOCAL CONSOLE
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The prompt
Remote Management  : [DISABLED]

will appear beneath the previous prompt.

The default of Remote Management is Disabled.

Pressing the spacebar on the keyboard will change the setting
to Enabled.  Pressing the spacebar again will change the
setting back to Disabled, and so forth.

Choices:

• Disabled  prohibits the remote site from managing the
router.

• Enabled allows the router to be managed from the remote
site (the site being called or that is calling).  When enabled,
the local site is still able to manage the router.  But, it is
recommended that a router be managed by only one site.  If
more than one site must be used to manage a router, it is
recommended that if you are using OverLAN Commander
you should exit after each session is complete.

Press the Enter key when you are ready to continue.
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The prompt
System Messages  : [Quiet Mode]

will appear.

The default of System Messages is Quiet Mode.

Pressing the spacebar on the keyboard will change the setting
to Verbose Mode.  Pressing the spacebar again will change
the setting back to Quiet Mode, and so forth.

Choices:

• Verbose Mode causes the router to display messages
about the status of the system.  This mode is
recommended as an aid to troubleshooting.

• Quiet Mode causes the router to suppress the
messages about the status of the system.  Once the
router is configured and you are satisfied with the
settings, it is recommended to have System Messages
set to the Quiet Mode.

Press the Enter key when you are ready to continue.
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The prompt
Console Password  : [Not Required]

will appear.

The default of Console Password is Not Required.
Pressing the spacebar switches between Not Required and
Required.

Choices:

• Not Required makes the password you selected for
Unit Password inactive, or not required.

• Required makes the password you selected for Unit
Password active, or required.

This feature is useful when you want a password, but also
on occasion may want to disable it.

Press the Enter key when you are ready to continue.
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The prompt
Console Baud  : [9600]

will appear.

The default of Console Baud is 9600.

Pressing the spacebar on the keyboard will toggle to the next
setting in the sequence (9600, 4800, 2400, 1200, 19200).

Choices:

• Press the spacebar to select a different console baud rate.

• Do one of the following:
• Leave this feature unchanged by not

pressing the spacebar, or if you have already
pressed the spacebar, reselecting the original
baud rate again.

• Change the setting by pressing the spacebar.

Press the Enter key when you are ready to continue.

The following message will appear:

Is the above setup information correct? (y/n) -

Type n to start over with this section.

Type y to use the current settings.  While the settings will be
used by the router, they are not actually saved.  To save the
settings, you must select SAVE from the command prompt of
the OverLAN Operating System.

This completes Task 1 of Configuring with a Local Console.
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Task 3:  Configuring the ISDN Manager

From the Setup Menu,

Press 2

to configure the ISDN Manager.

The prompt
Telco. Type : [NI-1]

will appear at the bottom of the video display.

T he default of Telco. Type is ETSI.  Pressing the spacebar
switches among ETSI, NI-1, and ETSI Variant.

Choices:

• ETSI is the type of ISDN phone service used in locations
other than the USA and Germany.

• NI-1 is the type of ISDN phone service used in the USA.

• ETSI Variant is the type of ISDN phone service used in
Germany.

If you are unsure of the type of ISDN phone service, use the
default setting for this option.

If this option is set incorrectly, the router may not be able to
communicate with the phone switch and may not be able to
make or receive calls.

Press the Enter key when you are ready to continue.
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The prompt
Call Type : [By Command]

will appear beneath the previous prompt.

The default of Call Type is By Command.  Pressing the
spacebar switches between the available settings.

Choices:

• By Command is used when you want calls to be manually
placed.  In this setup, the router cannot place calls
automatically.

• On Demand instructs the router to place calls
automatically when data is received for the remote
network.  When On Demand is selected, Bandwidth on
Demand is automatically enabled (if PPP Multilink is
enabled).

• When one or both B-channels are selected as Permanent
Channels, then the selected channel(s) will remain open all
of the time.  If an error causes a disconnection, the router
will automatically redial the number and raise the line up
again.

When only B1 or B2is a permanent channel (unless you also
have PPP Multilink and Bandwidth on Demand enabled),
then any calls or hangups on the remaining (nonpermanent)
B-channel must be performed manually.

Press the Enter key when you are ready to continue.
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The prompt
Send Broadcasts : DISABLED

may appear beneath the previous prompt.

This prompt appears only if any ON DEMAND is selected.

Choices:

• Enabled allows network broadcasts to raise the ISDN line.

• Disabled prevents network broadcasts from raising the
ISDN line.

Press the Enter key when you are ready to continue.
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The prompt
Call Timeout :000

may appear beneath the previous prompt.

This prompt appears only if no Permanent Channels are
selected.

Choices:

• Type a number for the numer of seconds the router will
keep a line up when there is no activity.  A value of 0 will
be interpreted as infinity, which means a call will nevern
timeout.  You should determine the line charges in order to
optimize Call Timeout.

• Leave this feature unchanged by not typing anything.

Press the Enter key when you are ready to continue.
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The prompt
Bandwidth on Demand: [Disabled]
may appear beneath the previous prompt.

This prompt will not appear if On Demand is selected for
Call Type (described earlier in this section of the manual)
with PPP Multilink enabled.

The default of Bandwidth on Demand is Disabled.

Pressing the spacebar on the keyboard will change the
setting to Enabled.  Pressing the spacebar again will
change the setting back to Disabled, and so forth.

Choices:

• Disabled prohibits the router from automatically opening a
second B-channel to handle larger data flows.  If this
feature is disabled and the router is setup to use both
B-channels, then the router will use both channels
regardless of the amount of data being transferred.

• Enabled allows the router to automatically open a second
B-channel  when there is sufficient data to require both
channels.

Press the Enter key when you are ready to continue.

NOTE:  Due to the varieties and complexities of networks and
applications, it is the responsibility of your network administrator,
and not that of Ringdale, to determine the cost of all line charges, or
any other charges which may be incurred, resulting from the use of
the OverLAN Ethernet/ISDN router.  Such charges are not the
responsibility of Ringdale.
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The prompt
Maximum # of calls  :   001

will appear beneath the previous prompt.

Choices:

• Type a number for the maximum number of calls the
router should make to the remote device when trying to
establish a link.  For reasons such as call collisions (when
both devices try to call each other simultaneously), some
devices may not pick up on an initial call but may pick up
on a subsequent call.

• Leave this feature unchanged by not typing anything.

Press the Enter key when you are ready to continue.
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The prompt
My B1 Phone number :

will appear beneath the previous prompt.

Choices:

• Type the ISDN phone number of your router.

Some ISDN lines have two phone numbers. If this is the
case, type the ISDN phone number corresponding to
channel B1 here.

• Type nothing if you do not wish to use the B1-channel.

Press the Enter key when you are ready to continue.
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The prompt
My B2 Phone number :

will appear.

Choices:

Do one of the following:
• If your router has only one ISDN phone number,

type that same number here again.

• If your router has two ISDN phone numbers, type
the second number here.  The second  number
should correspond to channel B2.

• Type nothing if you do not wish to use the B2-channel.

Even hough there are two B-channels (and even if the phone
numbers are two different numbers), only one remote device
at any given time should be allowed to call your router or
have an active communications link with your router.

Press the Enter key when you are ready to continue.
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The prompt
Dest B1 Phone number :

will appear beneath the previous prompt.

Choices:

• Type the ISDN phone number of the remote router
you are calling.

Some ISDN lines have two phone numbers. If this is the
case, type the ISDN phone number corresponding to
channel B1 here.

• Type nothing if you do not wish to use the B1-channel.

Press the Enter key when you are ready to continue.
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The prompt
Dest B2 Phone number :

will appear.

Choices:

Do one of the following:
• If the remote router has only one ISDN phone

number, type that same number here again.

• If the remote router has two ISDN phone
numbers, type the second number here.  The second
number should correspond to channel B2.

• Type nothing if you do not wish to use the B2-channel.

Though the numbers can be different, the ISDN phone
number supplied the B2 channel must call the same remote
device as the ISDN phone number supplied for the B1
channel.

Press the Enter key when you are ready to continue.
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The prompt
Local B1 SPID number :

will appear.

A SPID number may be needed if you set Telco. Type to
NI-1.  You should consult your Network Administrator to
find out if a SPID number is required.

Choices:

• Type your router’s ISDN SPID number (provided by
the phone company).

If you acquired two ISDN SPID numbers for your
router,  type the one corresponding to channel B1 here.

• Type nothing if SPIDs are not required in your area.

Press the Enter key when you are ready to continue.
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The prompt
Local B2 SPID number  :

will appear.

A SPID number may be needed if you set Telco. Type to
NI-1.  You should consult your Network Administrator to
find out if a SPID number is required.

Choices:

Do one of the following:
• If your router has only one ISDN SPID number,

type that same number here again.

• If your router has two ISDN SPID numbers, type
the number corresponding to channel B2 here.

• Type nothing if SPIDs are not required in your area.

NOTE: ISDN Phone numbers and ISDN SPID numbers are
available from the phone company.  For more information  about
them,  you will need to contact your ISDN provider.

Press the Enter key when you are ready to continue.
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The prompt
Line Idle Detection  :

will appear.

Select this option if the device being called is an OverLAN
router (or another type of device that is compatible with Line
Idle Detection).  This option allows the router to detect
certain disruptions in the communications link with the
remote device and hang-up.  If you are not sure whether
the remote device supports Line Idle Detection, disable this
option.

Choices:

• Enable this option.

• Disable this option.

Press the Enter key when you are ready to continue.

The following message will appear:

Is the above setup information correct? (y/n) -

Type n to start over with this section.

Type y to use the current settings.  While the settings will be
used by the router, they are not actually saved.  To save the
settings, you must select SAVE from the command prompt of
the OverLAN Operating System.

You may now go to Task 4.
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CONFIGURING WITH A LOCAL CONSOLE

Task 4: Configuring the PPP Manager

From the Setup Menu,

Press 3

to configure the PPP Manager.

The prompt
PPP Multilink    : [Disabled]

will appear at the bottom of the video display.

The default of PPP Multilink is Disabled.

Pressing the spacebar switches between Disabled and
Enabled.

Choices:

• Enabled allows both B-channels to be used
simultaneously to increase the speed of the router.  But this
also increases long distance line costs.

• Disabled permits only one B-channel to operate at a
time.

Press the Enter key when you are ready to continue.
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The prompt
Min Frag. size  :   000000

will appear beneath the previous prompt.

The default for Min Frag. size is 0.

Choices:

• Type a number to represent the minimum size (in bytes) of
data that can be fragmented during multilink operations.
This feature may help in compatibility with devices made
by other manufacturers.  In some cases, you may need to
contact Technical Support at JRL Systems for  help in
establishing compatibility with certain types of devices.
The default and recommended value for this field is 0.

• Leave this feature unchanged by not typing anything.

Press the Enter key when you are ready to continue.
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The prompt
Receive PAP          : [Disabled]

will appear beneath the previous prompt.

The default of Receive PAP is Disabled.

Pressing the spacebar switches between Disabled and
Required.

Choices:

• Required requires any remote router seeking access
through your router to have a special identification and
password.  If you select this option, you will be prompted
for the indentification and password that should be used,
called the PAP Unit Id and PAP Unit Password.

• Disabled does not require any identification or
password for remote routers to have access through
your router.

Press the Enter key when you are ready to continue.
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The prompt
PAP Unit Id          :

may appear beneath the previous prompt.

Choices:

• Type a unit Id for devices calling in.

• Do one of the following:
• Leave this feature unchanged, even if it is blank,

by not typing anything.
• Erase the current unit Id with the back space key

and leave the feature blank or type a new Id.

Leaving this feature blank does not disable the option.  It
merely sets the unit Id to a blank value.  Devices calling in
must supply a blank value for the unit Id to gain access.

Press the Enter key when you are ready to continue.
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The prompt
PAP Unit Password          :

may appear beneath the previous prompt.

Choices:

• Type a unit password for devices calling in.

• Do one of the following:
• Leave this feature unchanged, even if it is blank,

by not typing anything.
• Erase the current unit password with the back

space key and leave the feature blank or type a
new password.

Leaving this feature blank does not disable the option.  It
merely sets the unit password to a blank value.  Devices
calling in must supply a blank value for the unit password to
gain access.

Press the Enter key when you are ready to continue.
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The prompt
Transmit PAP          : [Disabled]

will appear beneath the previous prompt.

The default of Transmitt PAP is Disabled.

Pressing the spacebar switches between Disabled and
Required.

Choices:

• Required allows the router to provide a special
identification and password, if required by a device it is
calling.  If youselect this option, you will be prompted for
the indentification and password that should be used, called
the PAP Peer Id and PAP Peer Password.

• Disabled does not allow the router to provide identification
or password for  routers it is calling.  If identification or
password are required by a remote device, the router will
hang up.

Press the Enter key when you are ready to continue.

CONFIGURING WITH A LOCAL CONSOLE



127

The prompt
PAP Peer Id          :

may appear beneath the previous prompt.

Choices:

• Type a peer Id for devices calling in.

• Do one of the following:
• Leave this feature unchanged, even if it is blank,

by not typing anything.
• Erase the current peer Id with the back space key

and leave the feature blank or type a new Id.

Leaving this feature blank does not disable the option.  It
merely sets the peer Id to a blank value.  Devices calling in
must supply a blank value for the peer Id to gain access.

Press the Enter key when you are ready to continue.
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The prompt
PAP Peer Password          :

may appear beneath the previous prompt.

Choices:

• Type a peer password for devices calling in.

• Do one of the following:
• Leave this feature unchanged, even if it is blank,

by not typing anything.
• Erase the current peer password with the back

space key and leave the feature blank or type a
new password.

Leaving this feature blank does not disable the option.  It
merely sets the peer password to a blank value.  Devices
calling in must supply a blank value for the peer password to
gain access.

Press the Enter key when you are ready to continue.
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The Prompt
PPP IP Assignment [Disabled]
will appear beneath the previous prompt.

The default of PPP IP Assignment is Disabled.  Pressing
the spacebar switches between Assigned and  Disabled.

Choices:

• Assigned makes the router assign an IP address to devices
calling in.  Devices calling in that won’t accept the
assigned IP address will not gain access through the router..

• Disabled does not require devices calling in to be assigned
an IP address.

Press the Enter key when you are ready to continue.
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The Prompt
Address Assignment :
may appear beneath the previous prompt.

This option only appears if PPP IP Assignment is set to
Assigned.  This is the IP address to assign to remote devices.

Choices:

• Type an IP Address to assign to devices calling in.  An IP
Address should be of the form xxx.xxx.xxx.xxx where each
xxx is in the range of 1 to 256.

• Do one of the following:
• Leave this feature unchanged by not typing

anything.
• Erase the current address with the back space

key and type a new IP address.

Note: This feature has a default value of 000.000.000.000 which is not a
valid IP address.  If you leave this value unchanged, devices calling in
will not gain access to the router.

Press the Enter key when you are ready to continue.

The following message will appear:

Is the above setup information correct? (y/n) -

Type n to start over with this section.

Type y to use the current settings.  While the settings will be
used by the router, they are not actually saved.  To save the
settings, you must select SAVE from the command prompt of
the OverLAN Operating System.

You may now go to Task 5.
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Task 5:  Configuring the IP Protocol

From the Setup Menu,

Press 4

to configure the IP Protocol.

The prompt
IP ROUTING         : Disabled

will appear at the bottom of the video display.

The default of IP Routing is Disabled.

Pressing the spacebar switches between Disabled and Enabled.

Choices:

• Enabled allows your router to route IP packets.

• Disabled prevents your router from routing IP
packets.

Press the Enter key when you are ready to continue.
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If you chose Enabled for IP Routing, then the following
additional prompts will appear:

For local IP address and local IP mask, type a number in the form of
_ _ _ . _ _ _ . _ _ _ . _ _ _, where  each _ _ _ is a number ranging from
001 to 255, and press the Enter key.

To leave a setting unchanged, press just the Enter key.

Local IP Address  :
This is the IP address for your Ethernet network.
Local IP Mask     :
This is the IP mask for your Ethernet network.

Then the prompt
Translation   : Disabled

will appear.

The default of Translation is Disabled.

Pressing the spacebar switches between Disabled and Enabled.

This feature allows the router to be used with a low-cost
Internet connection supporting dynamic IP address
assignment.

Then the prompt
WAN IP Mode   : Fixed/Assigned

will appear.

Some ISPs (Internet Service Providers) use dynamic IP
address assignment for which a different IP address can be
assigned with each connection.  If this is the case with your
ISP, the option Assigned should be selected with no Wan IP
address entered.  Other ISP's use a fixed Wan IP address
dedicated to your account.  In this case, you should set the
Wan IP address option to Fixed and type in the dedicated
Wan IP address.
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If WAN IP Assignment is set to Fixed then you must enter
the WAN IP Address at the prompt WAN IP Address.

Then the prompt
Translate Mode   :

will appear.

1 to 1 Static allows one computer on the local network to
have permanent access to the router (for the Internet, for
example).

1 to 1 Dynamic allows one computer at a time on the local
network has access to the router (for the Internet, for
example).

1 to Many allows many users on the local network
simultaneous access to the router (for the Internet, for
example) using a single dynamic IP address.

NOTE: If 1 to 1 Dynamic is selected, the router must be
locked by the user before Internet access is permitted and
released after closing the connection.  Select lock or release
from the toolbar, the Router menu, or from a pop-up menu
accessed by right-clicking on the router name in the list of
routers.

If 1 to 1 Static IP Address Translation is selected, then you
must type the IP address of the computer or device getting
access to the router. Reset of the router is required when
enabling this option.

Press the Enter key when you are ready to continue.
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Then the prompt
Default Gateway   : Disabled

will appear if Provider Mode is not enabled.

The default of Default Gateway is Disabled.

Pressing the spacebar switches between Disabled and Enabled.

Choices:

• Enabled allows a router or device on your Ethernet
network to act as a default address for handling IP
packets with destinations that cannot be determined by
static routing tables or by dynamic routing.

• Disabled allows your router to simply discard packets
with destinations that cannot be determined by static
routing tables or by dynamic routing.

Press the Enter key when you are ready to continue.
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If  Default Gateway is Enabled, the prompt
Gateway Address   :
will appear.

Type an IP address of the form _ _ _ . _ _ _ . _ _ _ . _ _ _, where
each _ _ _ is a number ranging from 001 to 255, and press
the Enter key.

The Gateway Address is the IP address of a router or device that your
router will send packets to which have destinations it cannot determine
by static routing tables or by dynamic routing.
The prompt
Proxy ARP          : Disabled

may appear.

The default setting for Proxy ARP is Disabled.

Pressing the spacebar switches between Disabled and Enabled.

Choices:

• Enabled allows your router to respond to ARP
requests for devices on your Ethernet network that
do not have a static routing table or dynamic
routing mode.

• Disabled assumes that all devices on your Ethernet
network are capable of using your router for ARP
requests without the router having to mediate.

Press the Enter key when you are ready to continue.
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The prompt
RIP Services       : Disabled

may appear.

The default of RIP Services is Disabled.

Pressing the spacebar switches between Disabled and Enabled.

Choices:

• Disabled is used when RIP is not available on
 your Ethernet network and you do not want to use
dynamic routing.

• Enabled is used when RIP is available on your
Ethernet network and you want to use dynamic
routing.

Press the Enter key when you are ready to continue.
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If you chose Enabled for RIP Services, then the prompt
Poison RIP         : Disabled

may appear.

The default of Poison RIP is Disabled, but it can be active only if RIP
Services has been Enabled.

Pressing the spacebar switches between Disabled and Enabled.

Choices:

• Enabled is used if Call Type is set for By Command.
If the phone line goes down, the router will advertise
that other networks are not in reach.

• Disabled is used if Call Type is set for On Demand.
If the phone line goes down, the router will continue to
advertise that other networks are still in reach.

Press the Enter key when you are ready to continue.
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The prompt
RARP Protocol      : Disabled

will appear.

The default of RARP Protocol is Disabled.
Pressing the spacebar switches between Disabled and Enabled.

Choices:

• Disabled should be used if you do not have a RARP
server on your IP network or if you want to decide
what your local IP address and local IP mask will be.

• Enabled allows the router to dynamically petition for
an IP address and IP Mask using RARP protocol.  In
other words, the local IP address and local IP mask
will automatically be assigned for your router by the
RARP server (regardless of whether they were already
assigned or not).

Press the Enter key when you are ready to continue.

The following message will appear:

Is the above setup information correct? (y/n) -

Type n to start over with this section.

Type y to use the current settings.  While the settings will be
used by the router, they are not actually saved.  To save the
settings, you must select SAVE from the command prompt of
the OverLAN Operating System.

You may now go to Task 6.
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Task 6:  Configuring the IPX Protocol

From the Setup Menu,

Press 5

to configure the IPX Protocol.

The prompt
IPX Routing        : Disabled

will appear at the bottom of the video display.

The default of IPX Routing is Disabled.

Pressing the spacebar switches between Disabled and Enabled.

Choices:

• Enabled allows your router to route Novell IPX
packets.

• Disabled prevents your router from routing Novell
IPX packets.

Press the Enter key when you are ready to continue.

CONFIGURING WITH A LOCAL CONSOLE



140

If you chose Enabled for IPX Routing, then the following
additional prompts will appear:

Local IPX Network :
Type in an IPX address of the form  _ _ _ _ _ _ _ _, where each _  is a
hexadecimal number  between 0 - 9 or A - F. This is your network
address.

Press the Enter key when you are ready to continue.
Then the prompt
IPX Frame Type   : Ethernet II

will appear.

The default of IPX Frame Type is Ethernet II.

Pressing the spacebar switches between Ethernet II,802.2, SNAP, and
802.3

If you have a Novell server on your Ethernet network, you must choose
the same frame type as the Novell server uses.

Choices:

• Ethernet II is used for an Ethernet network using the
Ethernet II frame type.

• Ethernet 802.2 is used for an Ethernet network using the
Ethernet 802.2 frame type.

• Ethernet SNAP is used for an Ethernet network using
the Ethernet SNAP frame type.

• Ethernet 802.3 is used for an Ethernet network using the
Ethernet 802.3 frame type.

Press the Enter key when you are ready to continue.
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The prompt
IPX RIP Spoofing  : Enabled

will appear.

The default of IPX RIP Spoofing is Enabled.

Pressing the spacebar switches between Enabled and Disabled.

Choices:

• Enabled helps prevent a phone line from being raised
when RIP packets from Novell servers advertising
networks are encountered.  This feature can help save
on long distance line charges.

• Disabled allows a phone line to be raised whenever
RIP packets from Novell servers advertising networks
are encountered.

Press the Enter key when you are ready to continue.
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The prompt
Watchdog Spoofing : Enabled

will appear.

The default of Watchdog Spoofing is Enabled.

Pressing the spacebar switches between Enabled and Disabled

Choices:

• Enabled prevents a phone line from being raised when
packets from Novell servers checking on client
connections are encountered.  This feature can help
save on long distance line charges.

• Disabled allows a phone line to be raised whenever
packets from Novell servers checking on client
connections are encountered.

Press the Enter key when you are ready to continue.
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The prompt
IPX SAP Spoofing  : Enabled

will appear.

The default of IPX SAP Spoofing is Enabled.

Pressing the spacebar switches between Enabled and Disabled.

Choices:

• Enabled prevents a phone line from being
unnecessarily raised when packets from Novell
servers advertising Novell servers are encountered.
This feature can help save on long distance line
charges.

• Disabled allows a phone line to be raised whenever
packets from Novell servers advertising Novell
servers are encountered.

NOTE: Due to the varieties and complexities of networks and
applications, it is the responsibility of your network administrator,
and not that of Ringdale., to determine the cost of all line  charges, or
any other charges which may be incurred, resulting from the use of
this Ethernet network/ISDN router. Such charges are not be the
responsibility of Ringdale.

Press the Enter key when you are ready to continue.
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The following message will appear:

Is the above setup information correct? (y/n) -

Type n to start over with this section.

Type y to use the current settings.  While the settings will be
used by the router, they are not actually saved.  To save the
settings, you must select SAVE from the command prompt of
the OverLAN Operating System.

You may now go to Task 7.
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Task 7:  Configuring BRIDGING

From the Setup Menu,

Press 6

to configure Bridging.

The prompt
BRIDGING             : Disabled

will appear at the bottom of the video display.

The default of BRIDGING is Disabled.

Pressing the spacebar switches between Disabled and Enabled.

Choices:

• Enabled allows you to use your router as a bridge
between two physical Ethernet networks.

• Disabled does not allow your router to act as a bridge
between two physical Ethernet networks.

Press the Enter key when you are ready to continue.
If you chose Enabled for BRIDGING, then the following
additional prompts will appear:

These prompts should only concern you if your Ethernet network uses
Ethernet II frames.

Press the spacebar for each of  the following choices in order to switch
between Disabled and Enabled.

CONFIGURING WITH A LOCAL CONSOLE



146

Press the Enter key after each choice, when you are ready to continue.

IP Filtering        : Disabled
IP Filtering defaults to Disabled.

Choices:
• Disabled allows IP packets to cross the bridge.
• Enabled prevents IP packets from crossing the bridge.

NetBEUI Filtering    : Disabled
NetBEUI Filtering defaults to Disabled.

Choices:
• Disabled allows NetBEUI packets to cross the bridge.
• Enabled prevents NetBEUI packets from crossing the bridge.

AppleTalk Filtering : Disabled
AppleTalk Filtering defaults to Disabled.

Choices:
• Disabled allows AppleTalk packets to cross the bridge.
• Enabled prevents AppleTalk packets from crossing the bridge.

IPX 802.3 Filter : Disabled
IPX 802.3 Filter defaults to Disabled.

Choices:
• Disabled allows IPX packets to cross the bridge.
• Enabled prevents IPX packets from crossing the bridge.

OTHER Filtering     : Disabled
Other Filtering is shown here to be Disabled.

Choices:
• Disabled allows packets other than IP, IPX, NetBEUI, and

AppleTalk to cross the bridge.
• Enabled prevents packets other than IP, IPX, NetBEUI,

and AppleTalk from crossing the bridge.
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All the above choices for filtering concern only Ethernet II
frames.  If your Ethernet network uses an Ethernet 802.3
or other types of frames, then the above filtering features
will have no effect regardless of whether they are Disabled
or Enabled.

After pressing the Enter key for Other Filtering, the
following message will appear:

Is the above setup information correct? (y/n) -

Type n to start over with this section.

Type y to use the current settings.  While the settings will be
used by the router, they are not actually saved.  To save the
settings, you must select SAVE from the command prompt of
the OverLAN Operating System.

You may now go to Task 8.
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Task 8: Configuring a Static Routing Table

If IP Routing is not set to Enabled, then you can skip this
task and go to Task 9.

From the Setup Menu,

Press 7

to configure a static IP routing table.

The video display will appear as in figure 11:

Figure 11

IP addresses of the form _ _ _ . _ _ _ . _ _ _ . _ _ _ go in the first three
columns for Network, Subnet Mask, and Router.  A number of the form
 _ _ _ goes in the fourth column for Hops.  Each _ _ _ is a number
between 001 and 255.

STATIC ROUTING TABLE
===================

Entry           Network   Subnet Mask            Router      Hops
------  ------------------------- --------------------------------- ---------------- -------
0
1
2
3
4
5
6
7
8
9

Command? (E = edit, D = delete, X = exit):
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A static routing table is used when you want to designate
the exact route a packet will travel through the network,
helpful when you want to control traffic on the network.

To create or edit an entry, type E.

To delete an entry, type D.

To exit from the static routing table, type X.

If you type D, the prompt
Entry to Delete?
will appear.

Type the number under the column Entry that corresponds to the
information you wish to delete.
Press the Enter key.
The information is deleted.

If you type E, the prompt
Entry to Edit?
will appear.

Type the number under the column Entry that corresponds to the
information you wish to edit.
Press the Enter key.

The following prompts will appear (Each item depends on your particular
network layout):

IP Network Address :
This is a network that is reachable locally by your router without it
having to route through ISDN.

Subnet Mask :
This is the subnet mask corresponding to the above network.
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Router IP Address :
This is the first router on the path a packet will take to reach the network
mentioned above.

Hops Away :
This represents how many routers a packet will pass through to arrive
at the network mentioned above.

After pressing the Enter key for Hops Away, the
following message will appear:

Is the above setup information correct? (y/n) -

Type n to start over with this section.

Type y to use the current settings.  While the settings will be
used by the router, they are not actually saved.  To save the
settings, you must select SAVE from the command prompt of
the OverLAN Operating System.
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Operating the Router
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Turning the Router on or off.

To turn on the router, follow the instructions in Task 3 of
Installing Your OverLAN Router.

To turn off the router, simply unplug the unit.  But, unless it’s
an emergency, be sure there is no data currently transferring.
To determine if data is transferring or not, you should look to
see if the indicator lights for Transmit and Receive are
currently lit.  If these indicator lights are lit, then data is
transferring. It is recommended that you wait until no data is
transferring before turning off the unit.

Using the Router Control Panel.

The following illustration shows the indicator lights and
buttons on the front of the router.

Front View of the OverLAN Router

OPERATING YOUR ROUTER



153

The following table gives explanations of all the indicator
lights.

The following table gives explanations of all the control
buttons.

The Reset and Aux buttons, if used in combination with
other buttons, provide different functions.  The following
table gives explanations of all the allowed button
combinations.

OPERATING YOUR ROUTER

Indicator
Light

On Off Steady
Blinking

Power Plugged into power
Not plugged into

power
N/A

Receive Receiving data Not receiving data N/A

Transmit Transmitting data Not transmitting data
Sending test

packets

Status Online Offline
Searching for

Ethernet

D Channel
Connection with
Phone Switch

No connection with
Phone Switch

N/A

B1 Channel Data channel open Data channel closed N/A

B2 Channel Data channel open Data channel closed N/A

Control Button Explanation

Open Channel
Raises the ISDN line using whatever channel
configuration is currently setup.

Close Channel
Lowers the ISDN line, closing only one channel
each time the button is pressed.

Aux
Pressing this button only has an effect if used in
combination with another button.

Reset
Closes all communication links and restarts the
router using the current configuration settings.
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There is another Reset button located on the back of the
router that performs the same function as the Reset button on
the front of the router.

Operating the Router from OverLAN Commander
for Windows 95/NT

For an introduction to OverLAN Commander, see the
Configuring Your Router section of the manual.

In OverLAN Commander, you can select from menu items
and toolbar buttons (after router properties are accessed).

In router properties, there are two dialog boxes for
monitoring the operation of the OverLAN router, the Status
and Statistics dialog boxes.

The Status dialog box, shown on the next page, provides
version and network location information about the router,
the current status of ISDN calls, and status messages from
the router about errors or other operational issues.

OPERATING YOUR ROUTER

Buttons Explanation

Aux + Reset
Reboot router using firmware from the
permanent EPROM (factory code).

Aux + ENTER key (on
keyboard of local console)

Activates autobaud detection (router
automatically detects the baud rate of
the local console and adjusts itself).

Close Channel + Reset
Clears setup and reverts to factory
default settings for current firmware.
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The Statistics dialog box, shown on the next page, provides
information of errors and the rate of data transfer over the
Ethernet and ISDN lines for both transmitted and received
data.  There is also a graphic display of bandwidth usage for
received and transmitted data.

OPERATING YOUR ROUTER
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For more information about OverLAN Commander for
Windows 95/NT, you may want to view the online help in
OverLAN Commander.

This completes the section Operating the Router from
OverLAN Commander for Windows 95/NT.

OPERATING YOUR ROUTER
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Operating the Router from OverLAN Commander
for Windows 3.xx.

For an introduction to OverLAN Commander, see the
Configuring Your Router section of the manual.
When OverLAN Commander is started, you will see the
following dialog box.

You must select a router (click on a router name) before any
OverLAN Coammander options can be accessed.

For version and network location information for OverLAN
Commander, select the System Info. button.

To restart the router and end all calls, select the Reset button.

For online help with OverLAN Commander, select the Help
button.

To exit the current session of OverLAN Commander, select
the Exit button.

OPERATING YOUR ROUTER
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To setup configuration options, select the Setup Router
button.  For specific instructions on configuration, see the
Configuring Your Router section of the manual.

To place calls or monitor the current operation of the router,
select the Router Maint. button.  The Router Maintenance
dialog box is shown on the next page.

The Router Maintenance dialog box provides version and
network location information about the router, status
information about current ISDN calls, statistics about errors
and the rate of data transfer for both transmitted and received
data, status messages from the router about errors and other
operational issues, and control buttons for starting and
ending calls.  You can also change the version of firmware
from RouterMaintenance and save and retreive setup files
(*.SUP) from a disk.

For more information about OverLAN Commander for
Windows 3.xx, you may want to view the online help in
OverLAN Commander.

OPERATING YOUR ROUTER
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This completes the section Operating the Router from
OverLAN Commander for Windows 3.xx.

Operating the Router from a Local Console.

For more information on setting up console operation,
initially starting the console, or accessing features, see the
Configuring Your Router section of the manual.

The menu for console operation (shown below) is viewed by
typing and entering a ‘?’ at the command prompt of the
OverLAN Operating System.

To use one of these commands:
Type the word for the command from the left column of the above list
or the abbreviation given in brackets from the middle column. When
you have completed typing the command, press the Enter key.

OPERATING YOUR ROUTER

O v e r L A N
Operating System        1.41
[unit designation]: ?
Command Options
------------------------------------------------------------------
CALL x [Cx] - Call ISDN Channel x.
CLOSE [CL] - Disconnect ISDN Channel.
RESET [RE] - Restart the OverLAN Unit.
SETUP [SU] - Enter OverLAN Setup Menu.
SYSOP [SY] - Enter OverLAN System Options Menu.
HELP [?] - Displays this message.

Router Status Commands:

STATUS [ST] - System Status.
STATS [SS] - Router Statistics.
NRIP [NR] - Novell Routing Info.
SAP [SP] - Novell SAP Info.
RIP [RP] - IP Routing Info.
ARP [AR] - ARP cache.
FILTER [FI] - Current MAC filters.
[unit designation]:
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O v e r L A N
System Operations menu

1. - Revert to Permanent OverLAN System
2. - Erase All Setup Information
3. - Perform ISDN Loopback Test

Selection:

To place a call, use the CALL x command.  Type either
CALL or C followed by a 1, 2, or M where 1 represents
channel B1, 2 represents channel B2 ,and M represents
multilinking (both channels).  Press Enter when you are
ready.

To close a channel, use the CLOSE command.  Type either
CLOSE or CL.  This command closes both channels if both
channels are open or, if only one channel is open, closes
whichever channel is open.  Press Enter when you are ready.

To restart the router and end all calls, use the RESET
command.  Type either RESET or RE and press Enter when
you are ready.

To configure the router, use the SETUP command.  Type
either SETUP or SU and press Enter when you are ready.
For more information on configuring the router, see the
Configuring Your Router section of the manual.

To enter the OverLAN Systems Pptions menu, use the
SYSOP command.  Type either SYSOP or SY and press
Enter when you are ready.  The SYSOP Menu is shown
below.

OPERATING YOUR ROUTER
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To view status information about the router and about current
ISDN calls, use the STATUS command.  Type either
STATUS or ST and press Enter when you are ready.

To view statistics about errors or the rate of data transfer for
transmitted or received data, use the STATS command.  Type
either STATS or SS and press Enter when you are ready.
To view Novell routing information, use the NRIP
command.  Type either NRIP or NR and press Enter when
you are ready.

To view Novell SAP information, use the SAP command.
Type either SAP or SP and press Enter when you are ready.

To view IP routing information, use the RIP command.
Type either RIP or RP and press Enter when you are ready.

To view ARP cache information, use the ARP command.
Type either ARP or AR and press Enter when you are ready.

To view information on current MAC filters, use the
FILTER command.  Type either FILTER or FI and press
Enter when you are ready.

For additional general information about routing options, you
may want to refer to explanations given in the sections on
configuring the router from OverLAN Commander.  The
helpfiles for OverLAN Commander also contain general
information that may be useful.

This completes the section Operating the Router from a
Local Console.

This also completes the Operating the OverLAN Router
section of the manual.

OPERATING YOUR ROUTER
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TROUBLESHOOTING YOUR ROUTER

Troubleshooting Your Router:

Trouble Suggestions

Goodlink light does not come on. Be sure the power light on the front of the
router is on. Be sure the hub is plugged in.
Check all cable connections.

Goodlink light is flashing. The goodlink light may flash for a few
moments before becoming solid. Flashing
indicates a proper connection to the hub.

Goodlink light is on without The goodlink light should become solid,
flashing. indicating that the link through the hub is

good.

ISDN phone number is wrong. Be sure all country codes and area codes for
the remote router are included when you
type in the ISDN phone number. Do not
use parenthesis or dashes.

SPID number is wrong.  Do not use parenthesis or dashes.

For further assistance please visit the technical support website at
http://www.hbmuk.com, select Technical Support Center, and select
ISDN Router Devices.

Ringdale, Inc. (USA)  888-288-9080   FAX 512-288-7210
Ringdale UK Ltd +44 (0) 1444 871349
Ringdale GmbH +49 (0) 6196 88 9273
Ringdale Inc +1 512 288 9080
Web Site http://www.ringdale.com/techsupport

Your comments can improve the OverLAN router, OverLAN
Commander, and the instructions used in this manual. Ringdale wants to
hear your comments about this product. Please send FAX to
+44 (0) 1444 870228, or write to:

Ringdale UK Ltd
56 Victoria Road
Burgess Hill
West Sussex
RH15 9LR   United Kingdom

Please include the model, serial number, and configuration used.
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GLOSSARY

Glossary

10BASE-2: IEEE standard for a type of Ethernet over coaxial cable.
Also called “Thin Ethernet.”

10BASE-5: IEEE standard for a type of Ethernet over coaxial cable.

10BASE-T: IEEE standard for a type of Ethernet.

25-9 pin adaptor: an adaptor that changes a 25-pin connector to 9 pins or
a  9-pin connector to 25 pins.

ASCII terminal: a terminal using the American Standard Code for
Information Interchange.

AUI: Autonomous Unit Interface or Attachment Unit Interface.

BRI: Basic Rate Interface. Provides two 64 kbps B channels
and one 16 kbps D channel.

BRI port: S/T interface.

bridge: a device that physically connects two networks together.

DB9-25: a type of communications cable.

dynamic routing: routing by Novell RIP.

Ethernet network: a local area network used for connecting computers,
printers, workstations, terminals, etc., within the same
building.

Filter: an operating parameter that when set will block the
transfer techniques to avoid raising an ISDN line except
when needed.

Good-link light: a light, or LED, on a hub indicating if the connection
through the hub is proper.

HUB: the central connection point for some Ethernet.
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GLOSSARY

LAN:          Local Area Network.

network: a combination of switching and transmission that
provides telecommunications between two or more
points.

network
administrator: whoever is in charge of managing your network.

NT-1: a Network Termination Unit that changes a
U-interface into an S/T interface.

packet: a block, or bundle, of data carried as a unit across a
network.

physical network: the actual cable or hub forming a network.

remote network: a network accessible through the router.

remote router: a router on a remote network.

RJ45 shielded: an RJ45 cable resistant to RF interference.

RJ45 unshielded: an RJ45 cable not resistant to RF interference.

RS-232: a set of standards specifying various electrical and
mechanical characteristics for interfaces between
computers, terminals, and modems.

server: a computer providing a service, such as shared
access to a file system, a printer, or electronic mail
system to LAN  users.

spoofing: techniques to avoid raising an ISDN line except
when needed.

static routing a table mapping out the exact route a packet will
table: take to reach a remote network..

S/T-interface: BRI port.

terminal software: software that emulates an ASCII terminal.
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GLOSSARY

termination: the end of the coaxial cable.

terminating
resistor: a resistor that caps the end of a coaxial cable.

thin coax: a coaxial cable (0.2-inch, RG58A/U 50-ohm) that
uses a smaller diameter than standard thick coax.

T-plug: a T-shaped adaptor that joins a device to a coaxial
cable.

U-interface: the ISDN phone jack.


